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ЛАБОРАТОРНАЯ  РАБОТА  № 1 

«Определение эффективных модулей упругости  
однонаправленного материала с использованием  
различных микромоделей» 

 

Исходные данные: композиционный материал состоит из упругого свя-

зующего, регулярно армированного в одном направлении упругими волок-

нами круглого сечения (рисунок 1.1). Свойства связующего (матрицы): мо-

дуль упругости М 5E = ГПа; коэффициент Пуассона М 0,3µ = . Свойства воло-

кон: В 100E = ГПа; В 0,3µ = . Диаметр волокна В 20d = мкм; расстояние между 

волокнами 24a = мкм. 

Цель: 

1) используя простейшую микромодель композита определить эффек-

тивный поперечный модуль упругости 2E ; 

2) при помощи микромодели, учитывающей форму волокон, найти 2E  

и коэффициент концентрации напряжений k , а также построить зависимость 

напряжений в матрице от вертикальной координаты ( )М yσ ; 

3) выполнить расчёт данных величин методом конечных элементов в 

среде ANSYS. 

 

 
Рисунок 1.1 – Поперечное сечение однонаправленного материала 

 

Для данного материала коэффициент армирования можно определить 

как 

x  

y  

22σ  22σ  

a  

α  

Волокна 

Матрица 

Вd  
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2

2 2

R R

Ra a

π πψ = = , 

где В 2R d=  – радиус волокна. 

Отметим, что простейшая микромодель композита учитывает только 

объёмное содержание компонентов, игнорирует форму и расположение во-

локон. Согласно этой модели эффективный (усреднённый) поперечный мо-

дуль упругости равен 

( )
В М

2
М В1

E E
E

E Eψ ψ
=

+ −
. 

Если предположить, что В МE E≫ , то данная формула примет вид 

М
2 1

E
E

ψ
≈

−
. 

Более сложная микромодель композита, учитывающая форму волокон, 

состоит из системы круглых волокон, помещённых в матрицу. Для попереч-

ного модуля упругости она даёт следующее выражение: 

М
2 2

1 1
arctg

2 1 41

E
E

π λ π
ψ λλ

 += − −− 
, 

где 

2 4R

a

ψλ
π

= = . 

Кроме того, данная модель позволяет приближённо учесть неравно-

мерность распределения напряжений в окрестности волокна и оценить проч-

ность материала с учётом возникающей концентрации напряжений. Распре-

деление напряжений в матрице здесь имеет вид 

( )
М 22

М
2 1 sin

E

E

σσ
λ α

=
−

. 

Отметим, что для получения зависимости от вертикальной координаты 

следует воспользоваться выражением cosy R α= . 

Учитывая, что максимальное значение Мσ  реализуется при 2α π= , 

коэффициент концентрации по отношению к средним напряжениям будет 

равен 
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( )

max
М М

22 2 1

E
k

E

σ
σ λ

= =
−

. 

При конечно-элементном моделировании данного материала достаточ-

но рассмотреть лишь небольшую область поперечного сечения, включаю-

щую четверть волокна и примыкающую к нему матрицу. При этом можно 

ограничиться решением плоской задачи теории упругости, выбрав тип ко-

нечных элементов PLANE182 или PLANE183 с опцией plane strain (плоская 

деформация). Глобальный размер элементов можно установить примерно 

равным В 40d . 
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ЛАБОРАТОРНАЯ  РАБОТА  № 2 

«Вычисление жесткостных характеристик  
многослойных композитов» 

 

Исходные данные: композит составляется из разноориентированных 

слоёв однонаправленного материала, имеющего следующие эффективные 

упругие свойства: продольный модуль упругости 1 180E = ГПа; поперечный 

модуль упругости 2 6,2E = ГПа; модуль сдвига в плоскости слоя 12 5G = ГПа; 

коэффициент Пуассона 12 0,25µ = . Толщина каждого слоя равна 0,12 мм. 

Цель: 

1) рассчитать матрицы мембранных, изгибных и мембранно-изгибных 

жесткостей многослойного пакета для следующих структур укладки слоёв: 

[30°/-30°/90°], [45°/0°/90°/-45°] и [ ± 45°]s; 

2) показать, что композиты [30°/-30°/90°] и [45°/0°/90°/-45°] при плос-

ком напряжённом состоянии являются квази-изотропными материалами. 

 

Матричное выражение, связывающее погонные силы [ ] { }x yN N N T=  и 

моменты [ ] { }x y xyM M M M=  с деформациями отсчётной плоскости 

[ ] { }xx yy xye e e e=  и изменениями кривизн пластины [ ] { }xx yy xyχ χ χ χ= , 

имеет вид 

N A B e

M B D χ
     

=     
     

, 

где [ ]A  – матрица мембранных жесткостей; [ ]D  – матрица изгибных жестко-

стей; [ ]B  – матрица мембранно-изгибных жесткостей, отвечающая за взаи-

мосвязь сил и изменений кривизн, моментов и деформаций. 

Матрицы [ ]A , [ ]B  и [ ]D  симметричны, имеют размер 3х3, и определя-

ются как 

[ ] ( )( ) ( ) ( 1)

1

[ ]
n

k k k

k

A z zκ −

=

= −∑ ; 

[ ] ( ) ( ){ }2 2( ) ( ) ( 1)

1

1
[ ]

2

n
k k k

k

B z zκ −

=

= −∑ ; 
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[ ] ( ) ( ){ }3 3( ) ( ) ( 1)

1

1
[ ]

3

n
k k k

k

D z zκ −

=

= −∑ . 

Здесь n  – число слоёв; ( )kz  – расстояние от отсчётной плоскости до верхней 

поверхности k -го слоя (если в качестве отсчётной выбирается срединная 

плоскость, то (0) 2z H= − ); ( )[ ]kκ  – матрица жёсткости материала слоя k  в 

общей системе координат: 

( ) ( )( ) ( ) т( ) ( )
1 1[ ] [ ] [ ] [ ]k kk kT Tκ κθ θ= , 

где  

( )

2 2

2 2( )
1

2 2

2

[ ] 2k

c s sc

T s c sc

sc sc c s

θ
 −
 =  
 − − 

, 

– матрица преобразования ( ( )sin ks θ= ; ( )cos kc θ= ); 

( ) ( ) ( )
1 21 1
( ) ( ) ( ) ( )
12 21 12 21

( ) ( ) ( ) ( )
12 2 2

( ) ( ) ( ) ( )
12 21 12 21

( )
12

0
1 1

[ ]
0

1 1

0 0

k k k

k k k k

k k k k

k k k k

k

E E

E E

G

µ
µ µ µ µ

κ µ
µ µ µ µ

 
 − − 
 =
 − − 
  

 

– матрица жёсткости материала слоя k  в местной системе координат 

( ( ) ( ) ( ) ( )
21 12 2 1
k k k kE Eµ µ= ). 

Отметим, что материал будет квази-изотропным, если его матрица жё-

сткости имеет структуру 

( )

2 2

2 2

0
1 1

1 0[ ] [ ]
1 1

0 0
2 1

E E

E E
A

H
E

µ
µ µ

µ
κ µ µ

µ

 
 − −
 
 = =  − −
 
 
 + 

, 

т.е. выполняются равенства 

( )11 22 14 24 44; 0;
2 1

Eκ κ κ κ κ
µ

= = = =
+

, 

где ( )2
12 11 11; 1Eµ κ κ κ µ= = − . 
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ЛАБОРАТОРНАЯ  РАБОТА  № 3 

«Исследование прочности композитной пластины  
при помощи CAE-системы ANSYS» 

 

Исходные данные: композитная пластина, геометрия которой показана 

на рисунке 3.1, находится под действием растягивающей нагрузки интенсив-

ностью 100q = Н/мм. Пластина представляет собой 4-слойный пакет, состав-

ленный из слоёв углепластика (каждый толщиной 0,3 мм) с углами армиро-

вания [45°/0°/90°/-45°]. Свойства углепластика: 4
1 16 10E = ⋅ МПа; 2E =  

38 10= ⋅ МПа; 3
12 4,8 10G = ⋅ МПа; 12 0,25µ = ; 1в 1100σ + = МПа; 1в 450σ − = − МПа; 

2в 33σ + = МПа; 2в 80σ − = − МПа; 12в 27σ = МПа. 

Допущение: игнорируется кромочный эффект, связанный с существен-

ным увеличением межслоевых напряжений вблизи свободных от нагрузки 

кромок. 

Цель: оценить прочность композитной пластины с помощью различных 

критериев разрушения; определить критическую (разрушающую) нагрузку. 

 

 
Рисунок 3.1 – Геометрия пластины 

 

Данная конструкция и нагрузка симметричны относительно двух осей, 

однако структура пакета слоев несимметрична относительно срединной 

плоскости. Поэтому пластину здесь следует моделировать полностью. Нача-

ло системы координат поместим в центр отверстия, причём ось  X направим 

вправо, а ось Y – вверх. 

200 

10
0 

20∅
 θ  

q  q  
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Следует отметить, что при расчёте композитов часто возникает про-

блема, связанная с нехваткой исходных данных. Так, например, в нашем слу-

чае для углепластика известны лишь характеристики в плоскости слоя. Для 

вычисления недостающих данных можно предложить следующий приём. 

При равномерном распределении волокон в однонаправленном материале, 

показанном на рисунке 3.2, его можно считать трансверсально изотропным с 

плоскостью изотропии (2, 3). При этом в плоскости изотропии 3 2E E=  и 

2
23

232(1 )

E
G

µ
=

+
. Если принять 23 0,3µ = , то получим 3

23 3,08 10G = ⋅ МПа. Кро-

ме того, в плоскостях (1, 2) и (1, 3), перпендикулярных плоскости изотропии, 

упругие свойства должны быть одинаковыми: 13 12G G=  и 13 12µ µ= . 

 

 
Рисунок 3.2 – Трансверсально изотропный материал 

 

Неопределенными для нас остались лишь пределы прочности 3вσ + , 3вσ − , 

23вσ  и 13вσ , характеризующие в основном расслоение композита. В нашем 

случае, поскольку кромочный эффект игнорируется, эти величины можно за-

дать произвольно большими. 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить пакет ANSYS, указать имя задачи, например Clab3. 

2. Установить тип используемых в расчёте конечных элементов – 4-узловой 

оболочечный элемент SHELL181: Main Menu>Preprocessor>Element 

Type>Add/Edit/Delete. 

Нажимаем Add  и выбираем  Structural Shell>Elastic 4node 181, OK. 

В окне «Element types» (типы элементов) нажимаем Options (опции) и для 

опции «Storage of layer data K8» (хранение выходных данных в слоях) ус-

танавливаем значение All layers (все слои). 

1 

2 

3 
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Следует напомнить, что по умолчанию в файл результатов записываются 

только данные для нижней поверхности первого (нижнего) слоя, для 

верхней поверхности последнего (верхнего) слоя и для слоя с максималь-

ным значением критерия разрушения. 

Далее OK и Close. 

3. Задать свойства углепластика: Main Menu >Preprocessor>Material Props>  

Material Models. 

Поскольку однонаправленный материал является ортотропным, в правом 

окне последовательно выбираем  Structural>Linear>Elastic>Orthotropic. 

При этом появляется диалоговая панель, где кнопка Choose Poisson’s Ratio 

(выбор коэффициента Пуассона) позволяет установить, будет ли исполь-

зоваться большее (Major_Pr) или меньшее (Minor_Nu) значение коэффи-

циента Пуассона в каждой плоскости. По умолчанию выбирается большее 

значение. Поэтому, например, в поле PRXY следует вводить значение ко-

эффициента 12µ , а не 21µ . 

В соответствующие поля вводим: 

EX: 16e4 (модуль упругости вдоль оси x  материала, МПа) 

EY: 8e3 (модуль упругости вдоль оси y  материала, МПа) 

EZ: 8e3 (модуль упругости вдоль оси z материала, МПа) 

PRXY: 0.25 (наибольший коэффициент Пуассона в плоскости xy) 

PRYZ: 0.3 (наибольший коэффициент Пуассона в плоскости yz) 

PRXZ: 0.25 (наибольший коэффициент Пуассона в плоскости xz) 

GXY: 4.8e3 (модуль сдвига в плоскости xy, МПа) 

GYZ: 3.08e3 (модуль сдвига в плоскости yz, МПа) 

GXZ: 4.8e3 (модуль сдвига в плоскости xz, МПа) 

OK. 

Закрываем панель. 

4. Ввести информацию по критериям разрушения: Main Menu> 

Preprocessor>Material Props>Failure Criteria>Add/Edit. 

При этом появляется окно, где можно выбрать номер материала, для кото-

рого будут вводиться данные по разрушению. Закрываем его кнопкой OK. 

В новой диалоговой панели в строке «Stress in Tension» вводим значения 

разрушающих напряжений для углепластика при растяжении, в строке 

«Stress in Compression» – при сжатии и в строке «Stress in Shear» – при 

сдвиге, как показано на рисунке 3.3. В конце нажимаем OK. 
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Рисунок 3.3 – Ввод разрушающих напряжений 

 
5. Задать структуру пакета слоёв: Main Menu >Preprocessor>Sections>Shell> 

Lay-up>Add/Edit. 

В поле «Name» указываем имя Sect и заполняем строки таблицы снизу 

вверх: 

 

 Thickness Material ID Orientation Integration Pts 
4 0.3 1 -45 3 
3 0.3 1 90 3 
2 0.3 1 0 3 
1 0.3 1 45 3 

 

Для добавления новой строки здесь следует нажать кнопку Add Layers. 

OK. 

6. Построить геометрическую модель пластины. 

Как видно из рисунка 3.1, геометрическая модель рассматриваемой пла-

стины может быть получена путём вычитания из прямоугольника 

200х100 мм круга радиусом 10 мм, центр которого совпадает с центром 

прямоугольника. 

6.1. Построить прямоугольник: Main Menu>Preprocessor>Modeling> 

Create>Areas>Rectangle>By 2 Corners. 

Вводим следующие параметры: координаты левого нижнего угла 

WP X = -100 и WP Y = -50; ширина Width = 200; высота Height = 100. 

Нажимаем  OK. 
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6.2. Построить круг: Main Menu>Preprocessor>Modeling>Create>Areas>  

Circle>Solid Circle. 

Вводим: координаты центра круга WP X = WP Y = 0; радиус Radius = 

10. OK. 

6.3. Выполнить булеву операцию вычитания круга из прямоугольника: 

Main Menu>Preprocessor>Modeling>Operate>Boolean>Subtract> 

Areas. 

На первый запрос указываем поверхность A1 (прямоугольник). По-

скольку центры тяжести прямоугольника и круга совпадают, здесь 

появится панель «Multiple_Entities» (совпадающие объекты). Закры-

ваем её кнопкой OK. Нажимаем OK в панели указания. 

На второй запрос указываем поверхность A2 (круг). В панели «Multi-

ple_Entities» нажимаем Prev (предыдущая) или Next (следующая) для 

выбора круга, OK. Нажимаем OK в панели указания. 

7. Задать локальную систему координат (которая в дальнейшем будет опре-

делять систему координат слоистых элементов): Utility Menu> 

WorkPlane>Local Coordinate Systems>Create Local CS>At WP Origin. 

Ничего не меняя, закрываем диалоговую панель кнопкой OK. При этом 

будет создана новая локальная система координат с номером 11, полно-

стью совпадающая с глобальной декартовой системой координат. 

8. Задать атрибуты элементов: Main Menu>Preprocessor>Meshing>  

MeshTool. 

В универсальной диалоговой панели генерации сеток «MeshTool» в верх-

нем списке «Element Attributes» (атрибуты элементов) выбираем Global 

(глобальные) и нажимаем распложенную правее кнопку Set (установить). 

Далее появляется новая панель, где указаны атрибуты элементов по умол-

чанию. Меняем здесь только номер системы координат элементов: 

 «Element type number»: 1 SHELL181 (номер типа элементов) 

 «Element coordinate sys»: 11 (номер системы координат элементов) 

 «Section number»: 1 Sect (номер сечения) 

OK. 

9. Разбить поверхность на конечные элементы: Main Menu>Preprocessor> 

Meshing>MeshTool. 

В разделе «Size Controls» (управление размером) диалоговой панели 

«MeshTool» нажимаем кнопку Set строки «Global» и в поле «Element edge 

length» (размер длины стороны элемента) вводим значение 5 (в мм), OK. 
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Для сгущения сетки в области концентрации напряжений с помощью 

кнопки Set строки «Lines» (линии) дополнительно установим меньший 

размер элементов на контуре отверстия. При этом на данном контуре ука-

зываем четыре линии, нажимаем OK и в поле «Element edge length» вво-

дим значение 1 (в мм), OK. 

Используем режим построения свободной сетки Free. 

Для генерации сетки нажимаем кнопку Mesh и указываем все поверхности 

(Pick All). 

Для проверки отобразим системы координат элементов: Utility Menu>Plot 

Ctrls>Symbols; включаем флаг «Element coordinate sys». OK.  

При этом ось ex  будет изображаться белым цветом, ось ey  – зелёным, а ez  

– синим. 

Оси ex  систем координат всех элементов должны быть направлены впра-

во, а ey  – вверх. Угол ориентации каждого слоя отсчитывается от оси ex  

(причём положительный в направлении оси ey ). Ось ez  определяет на-

правление последовательности укладки слоёв. 

После этого опцию отображения систем координат элементов следует от-

ключить. 

10. Задать граничные условия. 
В рассматриваемой задаче пластина не закреплена, т.е. является свобод-

ной. Для устранения возможности перемещения как жёсткого целого её 

нужно закрепить минимально необходимым числом правильно ориенти-

рованных связей. Так, для трёхмерного случая следует наложить шесть 

связей, направления которых не должны пересекаться на одной линии. 

Для этого воспользуемся командой задания перемещений в точках: 

Main Menu>Solution>Define Loads>Apply>Structural>Displacement>On 

Keypoints. 

Указываем нижний левый угол пластины, OK. В списке «DOFs to be con-

strained» (степени свободы, которые должны быть ограничены) выделяем 

три компоненты UX, UY и UZ, Apply. 

Далее указываем верхний левый угол пластины, OK. В списке «DOFs to be 

constrained» выделяем две компоненты UX и UZ, Apply. 

И наконец, указываем нижний правый угол пластины, OK. В списке 

«DOFs to be constrained» выделяем лишь одну компоненту UZ, OK. 

11. Приложить нагрузку. 
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В рассматриваемой задаче нагружение пластины осуществляется погон-

ными силами интенсивностью 100 Н/мм, распределёнными по коротким 

сторонам (см. рисунок 3.1). 

Следует отметить, что в программе ANSYS давление, приложенное к сто-

ронам оболочечных элементов, будет являться фактически погонной на-

грузкой. 

Воспользуемся командой задания давления на линиях: Main Menu> 

Solution>Define Loads>Apply>Structural>Pressure>On Lines. 

На запрос указываем две короткие стороны пластины (т.е. линии L2 и L4) 

и нажимаем OK. В поле «Load PRES value» вводим значение -100 (в Н/мм; 

знак минус требуется для задания растягивающей нагрузки). OK. 

12. Запустить задачу на счёт: Main Menu>Solution>Solve>Current LS. 

13. Отобразить поле перемещений: Main Menu>General Postproc>Plot 

Results>Contour Plot>Nodal Solu. 

Из списка доступных результатов выбираем Nodal Solution>DOF  

Solution>Z-Component of displacement (перемещение по оси Z), OK. 

Вращая изображение модели, можно заметить, что происходит сильный 

изгиб и закручивание пластины. Это обусловлено несимметричностью ук-

ладки слоёв относительно срединной плоскости. 

14. Оценить прочность композитной пластины. 

Прежде всего, выбираем слой и указываем его поверхность, для которой 

будут отображаться результаты расчёта: Main Menu>General Postproc> 

Options for Outp. 

В поле «Specified layer number» вводим номер слоя (в нашем случае от 1 

до 4) и в списке «Shell results are from» выбираем верхнюю (Top layer) или 

нижнюю (Bottom layer) поверхность слоя. OK. 

Далее воспользуемся обычной командой изображения узлового решения: 

Main Menu>General Postproc>Plot Results>Contour Plot>Nodal Solu. 

Из списка доступных результатов выбираем один из феноменологических 

критериев разрушения: Nodal Solution>Failure Criteria>Maximum Stress 

(критерий максимальных напряжений), Tsai-Wu Strength Index (показатель 

прочности по критерию Цая-Ву) или Inverse of Tsai-Wu Strength Ratio  

Index (инверсия коэффициента запаса прочности по критерию Цая-Ву). 

OK. 
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Анализируя результаты, можно обнаружить, что наибольшие значения 

критериев разрушения достигаются на верхней поверхности (TOP) по-

следнего четвертого слоя (LAYR = 4), как показано на рисунке 3.4. 

Отметим, что максимальное значение критерия максимальных напряже-

ний max
2 2,272ξ = , максимальное значение показателя прочности по крите-

рию Цая-Ву max
3 5,307aξ =  и максимальное значение инверсии коэффициен-

та запаса прочности по критерию Цая-Ву max
3 2,582bξ = . Поскольку по обо-

им критериям они больше единицы, при заданной нагрузке 100q = Н/мм 

произойдет разрушение рассматриваемой композитной пластины. 

Определим критическую нагрузку. 

Очевидно, что по критерию максимальных напряжений она будет равна 

кр max
2

100
44,01

2,272

q
q

ξ
= = = Н/мм. 

 
Рисунок 3.4 – Поле значений инверсии коэффициента запаса прочности  

по критерию Цая-Ву на верхней поверхности четвертого слоя 
 

Однако данный критерий не учитывает взаимное влияние напряжений на 

прочность композитной конструкции. 

Рассмотрим критерий Цая-Ву. 
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При расчете величины 3aξ  используется стандартная запись данного кри-

терия. Поскольку он является квадратичным, по значению max
3aξ  сложно 

судить о близости нагрузки к критической. Здесь можно говорить лишь о 

том, произойдёт разрушение или нет. 

При вычислении же 3bξ  применяется модифицированная запись критерия 

Цая-Ву. При этом величина, обратная max
3bξ , будет по сути дела коэффици-

ентом запаса прочности. 

Таким образом, по критерию Цая-Ву критическая нагрузка оказывается 

равной 

кр max
3

100
38,73

2,582b

q
q

ξ
= = = Н/мм. 

Если к рассматриваемой пластине приложить такую нагрузку, то макси-

мальные значения max
3aξ  и max

3bξ  будут, очевидно, равны единице. 

15. Выйти из программы: ANSYS Toolbar>QUIT. 

 

 

 

Замечание: в рассматриваемой задаче наблюдается сильный изгиб пла-

стины, причём прогибы значительно превышают толщину многослойного 

пакета. Поэтому для уточнения решения здесь следует выполнить геометри-

чески нелинейный анализ, т.е. учесть изменение конфигурации тела из-за 

больших перемещений (Large Displacement). Однако в этом случае критиче-

скую нагрузку можно будет найти лишь с использованием метода последова-

тельных приближений. 
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ЛАБОРАТОРНАЯ  РАБОТА  № 4 

«Исследование прочности композитной пластины  
при помощи CAE-системы MSC.Patran/Nastran» 

 

Исходные данные: композитная пластина с отверстием, геометрия ко-

торой показана на рисунке 4.1, находится под действием растягивающей на-

грузки интенсивностью 25q = Н/мм. Пластина представляет собой 4-слойный 

пакет, составленный из слоёв углепластика (каждый толщиной 0,3 мм) с уг-

лами армирования [45°/0°/90°/-45°]. Свойства углепластика: 4
1 16 10E = ⋅ МПа; 

3
2 8 10E = ⋅ МПа; 3

12 4,8 10G = ⋅ МПа; 12 0,25µ = ; 1в 1100σ + = МПа; 1вσ − =  

450= − МПа; 2в 33σ + = МПа; 2в 80σ − = − МПа; 12в 27σ = МПа. 

Допущение: игнорируется кромочный эффект, связанный с существен-

ным увеличением межслоевых напряжений вблизи свободных от нагрузки 

кромок. 

Цель: оценить прочность композитной пластины с помощью различных 

критериев разрушения; определить критическую (разрушающую) нагрузку. 

 

 
Рисунок 4.1 – Геометрия пластины 

 

Данная конструкция и нагрузка симметричны относительно двух осей, 

однако структура пакета слоёв несимметрична относительно срединной 

плоскости. Поэтому пластину здесь следует моделировать полностью. Нача-

ло системы координат поместим в центр отверстия, причем ось  X направим 

вправо, а ось Y – вверх. 

200 

10
0 

20∅
 θ  

q  q  
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Следует отметить, что при расчёте композитов часто возникает про-

блема, связанная с нехваткой исходных данных. Так, например, в нашем слу-

чае для углепластика известны лишь характеристики в плоскости слоя. Для 

вычисления недостающих данных можно предложить следующий приём. 

При равномерном распределении волокон в однонаправленном материале, 

показанном на рисунке 4.2, его можно считать трансверсально изотропным с 

плоскостью изотропии (2, 3). При этом в плоскости изотропии 3 2E E=  и 

2
23

232(1 )

E
G

µ
=

+
. Если принять 23 0,3µ = , то получим 3

23 3,08 10G = ⋅ МПа. Кро-

ме того, в плоскостях (1, 2) и (1, 3), перпендикулярных плоскости изотропии, 

упругие свойства должны быть одинаковыми: 13 12G G=  и 13 12µ µ= . 

 

 
Рисунок 4.2 – Трансверсально изотропный материал 

 

Неопределёнными для нас остались лишь пределы прочности 23вσ  и 

13вσ , характеризующие в основном расслоение композита. В нашем случае, 

так как кромочный эффект игнорируется, эти величины можно задать произ-

вольно большими. 

Поскольку слоистый композит здесь имеет простую структуру (т.е. все 

слои покрывают одну и ту же область), то для построения его модели можно 

воспользоваться как обычными средствами программы MSC.Patran, так и 

специализированным приложением MSC.Laminate Modeler. Рассмотрим оба 

подхода. 

Для решения задачи предлагается выполнить следующие действия. 

I.  Построение модели слоистого композита средствами препроцессора 
MSC.Patran 

1. Запустить программу MSC.Patran и открыть новую базу данных. 

В полосе меню выбираем команду File>New. 

1 

2 

3 
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В поле «File name» указываем имя файла базы данных Clab4.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» (точность геометрического моделирования) диало-

говой панели «New Model Preference» выбираем опцию «Based on Model» 

(на основе модели) и в поле «Model Dimension» (габаритный размер моде-

ли) вводим значение 200 (в мм), OK. 

3. Построить прямоугольную поверхность. 

Выбираем приложение «Geometry» и устанавливаем сочетание Create/ 

Surface/XYZ. 

В соответствующие поля вводим: 

 «Vector Coordinates List»: <200 100 0> (описывающий диагональ век-

тор, мм) 

 «Origin Coordinate List»: [-100 -50 0] (координаты начала вектора, мм) 

Apply. 

4. Сделать отверстие. 
Устанавливаем сочетание Edit/Surface/Add Hole. 

Вводим: 

 «Hole Radius»: 10 (радиус отверстия, мм) 

 «Surface»: Surface 1 (поверхность) 

 «Center Point List»: [0 0 0] (координаты центра отверстия, мм) 

Apply. 

5. Задать опорные точки сетки. 

Выбираем приложение «Elements».  

Для задания равномерного расположения опорных точек сетки устанавли-

ваем сочетанием Create/Mesh Seed/Uniform. 

Используя опцию «Element Length (L)», вводим размер элементов (в мм): 

Length = 1. 

Активизируем поле «Curve List» и указываем кромку круглого отверстия. 

При необходимости нажимаем  Apply. 

6. Разбить поверхность на конечные элементы. 

Устанавливаем сочетание Create/Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad (четырёхугольная форма) 

 «Mesher»: Paver (генератор свободных сложных сеток) 

 «Topology»: Quad4 (топология – четырёхугольник с четырьмя узлами). 
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Активизируем поле «Surface List» и в графическом окне указываем по-

верхность 1. 

В разделе «Global Edge Length» отключаем опцию автоматического вы-

числения глобальной длины стороны элемента и в поле «Value» вводим 

значение 5 (в мм). Apply. 

7. Задать свойства слоя углепластика. 
Запускаем приложение «Materials» и для задания свойств двухмерного ор-

тотропного материала выбираем сочетание Create/2d Orthotropic/Manual 

Input. 

В поле «Material Name» вводим имя материала, например layer. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 16e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 8e3 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.25 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 4.8e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 3.08e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 4.8e3 (модуль сдвига 13G , МПа) 

OK. 

Нажимаем кнопку Apply. 

8. Ввести информацию по критерию разрушения. 

Для модели материала layer снова нажимаем Input Properties. 

В выпадающих меню выбираем: 

 «Constitutive Model»: Failure (модель состояния – разрушение) 

 «Failure Limits»: Stress (ввод разрушающих напряжений) 

 «Composite Failure Theory»: Tsai-Wu (теория разрушения композитов 

Цая-Ву). 

Вводим значения разрушающих напряжений: 

 «Tension Stress Limit 11» = 1100 (предел прочности при растяжении 

вдоль волокон 1вσ + , МПа) 

 «Tension Stress Limit 22» = 33 (предел прочности при растяжении попе-

рёк волокон 2вσ + , МПа) 

 «Compress Stress Limit 11» = 450 (модуль предела прочности при сжа-

тии вдоль волокон 1в| |σ − , МПа) 
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 «Compress Stress Limit 22» = 80 (модуль предела прочности при сжатии 

поперёк волокон 2в| |σ − , МПа) 

 «Shear Stress Limit» = 27 (предел прочности при сдвиге в плоскости 

слоя 12вσ , МПа) 

 «Interaction Term» = -0.5 (коэффициент взаимного влияния IXY) 

 «Bonding Shear Stress Limit» = 1000 (предел прочности при межслоевом 

сдвиге 23вσ  и 13вσ , МПа) 

OK. 

Нажимаем кнопку Apply. 

Следует отметить, что помимо критерия разрушения Цая-Ву здесь можно 

выбирать также критерии максимальных напряжений (Maximum), Хилла 

(Hill), Хоффмана (Hoffman) и др. 

9. Построить модель слоистого композита. 
Устанавливаем сочетание Create/Composite/Laminate. 

При этом появляется дополнительная панель «Laminate Composite». 

Сначала в основной диалоговой панели приложения «Materials» в поле 

«Material Name» вводим имя композита, например comp. 

Затем здесь же в списке существующих материалов «Existing Materials» 

четыре раза мышью указываем материал layer, что приведет к заполнению 

первого столбца таблицы дополнительной панели. 

Далее активизируем первую ячейку столбца «Thickness» (толщина) и в 

поле «Set Thickness = ... For All Layers of “layer”» (установить одинаковую 

толщину для всех слоёв из материала layer) вводим значение 0.3 (в мм). 

После нажатия клавиши Enter будет заполнен второй столбец. 

И наконец, активизируем первую ячейку столбца «Orientation» (ориента-

ция), в поле «Input Data» вводим значение 45 (в градусах) и нажимаем 

клавишу Enter. 

Аналогично вводим числа 0, 90, -45 (рисунок 4.3). 

В конце нажимаем кнопку Apply основной панели приложения. 

После этого, нажав кнопку Show Laminate Properties дополнительной па-

нели, можно вывести на экран матрицы жесткостных характеристик мно-

гослойного пакета. 

10. Определить свойства элементов. 
Выбираем приложение «Properties». Для задания свойств оболочечных 

элементов устанавливаем сочетание Create/2D/Shell. 
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Рисунок 4.3 – Ввод материала, толщины и ориентации слоёв пакета 

 

В поле «Property Set Name» вводим имя набора свойств, например prop. 

Для опции, определяющей тип сечения оболочки, значение Homogeneous 

(однородное) меняем на Laminate (слоистое). 

Нажимаем кнопку Input Properties. При этом появляется дополнительное 

окно, где будет выбран стандартный элемент слоистой пластины Stan. 

Lam. Plate (CQUAD4/PCOMP). 

Нажимаем кнопку     и из списка существующих материалов выбираем 

comp. 

Для поля «Material Orientation» (ориентация материала) указываем гло-

бальную декартову систему координат (Coord 0). При этом углы ориента-

ции слоёв будут отсчитываться от оси  X данной системы координат. 

Закрываем окно кнопкой OK. 

Нажимаем кнопку Select Application Region и указываем поверхность 1.  

Затем последовательно нажимаем  Add, OK и  Apply. 

11. Проверить созданную модель. 

Хорошим правилом является проверка модели до выполнения анализа, 

особенно, когда Вы имеете дело со слоистыми композитами. Напомним, 

что первый слой – это нижний слой элементов. Определить, где низ, а где 

верх у элемента, можно с помощью вектора нормали, показывающего на-

правление снизу вверх. 

Для проверки ориентации нормалей элементов запускаем приложение 

«Elements» и устанавливаем сочетание Verify/Element/Normals. 



 23

Выбираем опцию «Draw Normal Vectors» (отобразить векторы нормалей), 

Apply. 

Вращая модель, убедитесь в том, что все векторы направлены в одну сто-

рону (т.е. нет «перевёрнутых» элементов). 

Для восстановления предыдущего вида нажимаем кнопку Reset Graphics. 

К сожалению, MSC.Patran не позволяет отображать направления волокон 

в отдельных слоях. 

12. Задать граничные условия. 
В рассматриваемой задаче пластина не закреплена, т.е. является свобод-

ной. Для устранения возможности перемещения как жёсткого целого её 

нужно закрепить минимально необходимым числом правильно ориенти-

рованных связей. Так, для трёхмерного случая следует наложить шесть 

связей, направления которых не должны пересекаться на одной линии. 

Запускаем приложение «Loads/BCs» и для задания перемещений устанав-

ливаем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя вновь создаваемого набора, например 

xyz. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,0,0>, OK. 

Нажимаем Select Application Region. Для выбора геометрических объектов 

устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (точка или вершина) и указываем нижний ле-

вый угол пластины. 

Последовательно нажимаем кнопки Add, OK и Apply. 

Далее в поле «New Set Name» вводим другое имя, например xz. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,,0>, OK. 

Нажимаем Select Application Region и для поля «Select Geometry Entities» 

указываем верхний левый угол пластины. 

Последовательно нажимаем кнопки Add, OK и Apply. 

Затем в поле «New Set Name» вводим ещё одно имя, например z. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <,,0>, OK. 

Нажимаем Select Application Region и для поля «Select Geometry Entities» 

указываем нижний правый угол пластины. 

Последовательно нажимаем кнопки Add, OK и Apply. 

13. Приложить нагрузку. 
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В рассматриваемой задаче нагружение пластины осуществляется погон-

ными силами интенсивностью 25 Н/мм, распределёнными по коротким 

сторонам (см. рисунок 4.1). 

Следует отметить, что в системе MSC.Patran-Nastran давление, приложен-

ное к сторонам оболочечных элементов, будет являться фактически по-

гонной нагрузкой. 

В том же приложении устанавливаем сочетание Create/Pressure/Element 

Uniform. 

В поле «New Set Name» вводим имя нового набора, например load. 

В качестве типа целевых элементов выбираем поверхностные, т.е. «Target 

Element Type»: 2D. 

Нажимаем кнопку Input Data и в поле «Edge Pressure» (давление на кром-

ке) вводим значение -25 (положительное давление направлено к поверх-

ности и вызывает сжатие, а в нашем случае необходимо задать растяже-

ние, поэтому мы вводим отрицательное число). OK. 

Далее нажимаем кнопку Select Application Region. Используем опцию «Se-

lect»: Geometry. 

Активизируем поле «Select Surfaces or Edges», в пиктографическом меню 

выбора нажимаем кнопку      (кромка) и указываем левую и правую кром-

ки модели, используя клавишу Shift. 

Последовательно нажимаем кнопки Add, OK и  Apply. 

14. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Ничего не меняя, нажимаем кнопку Apply. 

15. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

clab4.xdb, OK. 

В заключение нажимаем Apply. 

16. Отобразить поле перемещений. 

Выбираем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 
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В списке «Select Fringe Result» в качестве величины для многоцветного 

представления её поля указываем Displacements, Translational (поступа-

тельные перемещения). 

Ниже в меню «Quantity» выбираем компоненту Z Component. 

Далее в списке «Select Deformation Result» в качестве результата для изо-

бражения деформированного состояния модели указываем строку Dis-

placement, Translational. 

Нажимаем  Apply. 

Вращая изображение модели, можно заметить, что происходит сильный 

изгиб и закручивание пластины. Это обусловлено несимметричностью ук-

ладки слоёв относительно срединной плоскости. 

17. Создать новый случай результатов, содержащий рассчитанные значения 

критериев разрушения. 

В полосе меню выбираем команду Tools>Laminate Modeler>Laminate. 

При этом справа появляется диалоговая панель, где устанавливаем соче-

тание Create/Results/Failure Calc. 

В списке «Select Results Cases» указываем единственный случай результа-

тов, а в списке «Select Layered Result» – Stress Tensor. 

Далее активизируем поле «Select Area» и в графическом окне зоной выбо-

ра в виде прямоугольника охватываем всю модель. 

В выпадающем меню «Criterion» в качестве критерия разрушения выбира-

ем Tsai-Wu. 

В поле «Name» вводим имя набора результатов, например old. 

Нажимаем Apply. 

Если появляется сообщение о неправильном задании коэффициента вза-

имного влияния, для параметра F12 вводим значение -0.5. 

Аналогично выбираем другие критерии разрушения (Maximum, Hill, 

Hoffman), каждый раз выделяя первый случай результатов и Stress Tensor 

и завершая ввод нажатием кнопки Apply. Следует отметить, что критерии 

Hankinson и Cowin работают нестабильно. 

В конце кнопкой Close закрываем диалоговую панель «Composite 

Modeler». 

18. Оценить прочность композитной пластины. 

Если в диалоговой панели приложения «Results» не появился второй слу-

чай результатов, то следует данное приложение закрыть и снова открыть. 

В списке «Select Result Cases» выбираем второй случай результатов. 
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При этом в списке «Select Fringe Result» по каждому выбранному крите-

рию разрушения будут представлены следующие результаты:  

• Critical Components (Worst)*... – номера критических компонент тензора 

напряжений в пакете; 

• Critical Components*... – номера критических компонент тензора напря-

жений в отдельных слоях пакета; 

• Critical Layers (Worst)*... – номера критических (т.е. наиболее нагружен-

ные) слоёв; 

• Failure Indices (Worst)*... – наихудшие (т.е. наибольшие по слоям) значе-

ния критерия разрушения; 

• Failure Indices*... – значения критерия разрушения в отдельных слоях; 

• Margins of Safety (Worst)*... – наихудшие (т.е. наименьшие по слоям) 

значения коэффициента запаса безопасности; 

• Margins of Safety*... – значения коэффициента запаса безопасности в от-

дельных слоях. 

Указываем строку Failure Indices (Worst)*, Tsai-Wu Stress (old). 

Нажимаем Apply. 

Получаемое при этом изображение представлено на рисунке 4.4. Видно, 

что максимальное значение критерия Цая-Ву maxFI  составляет 0,397. По-

скольку оно меньше единицы, при заданной нагрузке 25q = Н/мм рас-

сматриваемая композитная пластина будет удовлетворять условию проч-

ности. 

 

 
Рисунок 4.4 – Наибольшие по слоям значения критерия разрушения Цая-Ву 
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Если в списке «Select Fringe Result» указать строку Failure Indices*, Tsai-

Wu Stress (old), то можно будет просматривать значения критерия разру-

шения Цая-Ву в отдельных слоях композитной пластины. При этом ниже 

с помощью кнопки Position можно выбрать номер слоя. 

Следует отметить, что значения критериев разрушения здесь рассчитыва-

ются только для срединной поверхности каждого слоя. 

Определим критическую (разрушающую) нагрузку. 

Поскольку критерий Цая-Ву является квадратичным, по значению maxFI  

сложно судить о близости нагрузки к критической. Здесь можно говорить 

лишь о том, произойдет разрушение или нет. 

В списке «Select Fringe Result» указываем строку Margins of Safety 

(Worst)*, Tsai-Wu Stress (old). 

Нажимаем Apply (рисунок 4.5). 

 

 
Рисунок 4.5 – Наименьшие по слоям значения коэффициента запаса  

безопасности по критерию Цая-Ву 
 

Видно, что минимальное значение коэффициента запаса безопасности по 

критерию Цая-Ву minMoS  составляет 0,895. 

Теперь можно найти минимальное значение коэффициента запаса прочно-

сти (Strength Ratio): 
min min 1 1,895SR MoS= + = . 

Таким образом, по критерию Цая-Ву критическая нагрузка оказывается 

равной 
min

кр 25 1,895 47,4q q SR= ⋅ = ⋅ = Н/мм. 
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Если к рассматриваемой пластине приложить такую нагрузку, то макси-

мальное значение критерия Цая-Ву maxFI  будет, очевидно, равно единице. 

Для сравнения в таблице 4.1 представлены результаты расчёта критиче-

ской нагрузки при использовании различных критериев разрушения. 

 

Таблица 4.1 – Расчёт критической нагрузки 

Критерий  
разрушения 

maxFI  minMoS  minSR  крq , Н/мм 

Maximum 0,445 1,250 2,250 56,3 
Tsai-Wu 0,397 0,895 1,895 47,4 
Hill 0,270 0,923 1,923 48,1 
Hoffman 0,400 0,872 1,872 46,8 

 

Можно заметить, что для критерия максимальных напряжений (содержа-

щего только линейные члены) min max1SR FI= , а для критерия Хилла (со-

держащего только квадратичные члены) min max1SR FI= . В остальные 

критерии разрушения входят как линейные, так и квадратичные члены. 

Поэтому при их использовании коэффициент запаса прочности находится 

из решения квадратного уравнения. 

 

II.  Построение модели слоистого композита средствами приложения 
MSC.Laminate Modeler 

19. Удалить результаты. 

В приложении «Results» устанавливаем сочетание Delete/Result Cases. 

Используя клавишу Shift, выделяем оба случая результатов, Apply. 

Если появится информационное окно с сообщением, закрываем его кноп-

кой Yes. 

20. Удалить свойства элементов и модель слоистого материала. 

Выбираем приложение «Properties» и для удаления свойств оболочечных 

элементов устанавливаем сочетание Delete/2D/Shell. 

Ниже в списке выделяем строку prop. 

Нажимаем кнопку Add, а затем – Apply. 

Запускаем приложение «Materials» и устанавливаем сочетание Delete/ 

Composite. 

В списке существующих материалов выбираем строку comp, Apply. 

21. Открыть новую базу данных в MSC.Laminate Modeler. 
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В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab4.Layup, OK. 

22. Создать LM-материал. 

В выпадающих меню приложения MSC.Laminate Modeler выбираем соче-

тание Create/LM_Material/Add. 

Устанавливаем проекционный тип материала, т.е. «Type»: Projection. 

В списке «Analysis Materials» указываем материал layer и в поле «Thick-

ness» вводим значение толщины (в мм): 0.3, Apply. 

Материал с именем Mat_1 должен появиться в списке «Existing 

LM_Materials». 

23. Создать LM-слои. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Здесь следует отметить, что для плоских поверхностей углы ориентации 

волокон однозначно определяются как при помощи имитации драпировки, 

так и методом простого проецирования. Однако драпировка многосвязан-

ных поверхностей вызывает определённые трудности (для преодоления 

которых можно, например, временно заполнить отверстия фиктивными 

элементами). Поскольку рассматриваемая пластина имеет отверстие, для 

ориентирования материалов будем использовать метод проецирования. 

Выбираем «Type»: Projection (проекционный). 

Для первого LM- слоя в списке «Select LM_Material» выбираем материал 

Mat_1. 

Активизируем поле «Select Area» и в графическом окне в качестве облас-

ти, покрываемой слоем, указываем поверхность 1 (Surface 1). 

За начальную точку принимаем левую нижнюю вершину поверхности, т.е. 

«Start Point»: Point 1. 

Далее вводим: 

 «Application Direction»: <0. 0. -1.> (направление прикладывания) 

 «Rotation Angle»: 45 (угол поворота) 

 «Method»: Projected X-axis (проекция оси X) 

Apply. 

При этом появится информационное окно с сообщением: The selected area 

contains interior holes, do you wish to continue? (Выбранная область содер-

жит внутренние отверстия, Вы хотите продолжить?). 
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Нажимаем Yes. 

В данном случае угол ориентации волокон (угол поворота) будет отсчи-

тываться от проекции оси X на поверхность против хода часовой стрелки, 

если смотреть по вектору направления прикладывания (т.е. против оси Z). 

Слой с именем Ply_1 должен появиться в списке «Existing LM_Plys». 

Для второго LM- слоя меняем только угол поворота, т.е. вводим «Rotation 

Angle»: 0. Apply. 

Аналогично для третьего и четвёртого LM- слоёв используем соответст-

венно углы 90 и -45. 

Ввод каждого слоя завершаем нажатием кнопки Apply. 

24. Создать LM-пакет. 

Устанавливаем сочетание Create/LM_Layup/Add. 

Нажимаем кнопку Layup Definition (определение пакета). 

При этом появляется дополнительное окно, где из расположенного внизу 

списка «Existing LM_Plys» последовательно выбираем слои Ply_1, Ply_2, 

Ply_3 и Ply_4. 

После заполнения таблицы нажимаем OK. 

Совместим отсчётную (узловую) плоскость со срединной плоскостью пла-

стины. Для этого нажимаем кнопку Offset Definition (определение отсту-

пов). 

Выбираем режим «Define Offsets». 

Выделяем первую строку таблицы «Define Offsets» и в соответствующие 

поля вводим: 

 «Select Area»: Surface 1 (выбор области) 

 «Definition Point»: Point 1 (определяющая точка) 

 «Definition Direction»: <0. 0. -1.> (определяющее направление взгляда) 

 «Offset Value»: 0 (значение отступа, мм) 

 «Offset Flag»: Middle (признак отступа) 

Create. 

В первой строке таблицы должна появиться запись Surface 1. 

Нажимаем последовательно  OK и  Apply. 

При этом появится информационное окно с сообщением: The analysis 

model will require 1 properties referencing 1 laminates, 0 materials, 0 coordi-

nates and 1 fields for the selected tolerance. Do you wish to continue? (Модель 

для анализа в соответствии с выбранной точностью требует создания 1 

набора свойств элементов, ссылающегося на 1 слоистый материал, 0 од-
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нородных материалов, 0 систем координат и 1 поле. Вы хотите продол-

жить?). 

Нажимаем Yes. 

25. Проверить созданную модель. 

Для проверки ориентации слоёв устанавливаем сочетание Show/LM_Ply/ 

Graphics. 

В списке существующих слоёв «Existing LM_Plys» выделяем слой Ply_1, 

Apply. 

При этом в графическом окне появится изображение конечно-элементной 

модели с указанием направления волокон в каждом элементе. 

Аналогично проверяем остальные слои. 

Для восстановления предыдущего вида нажимаем кнопку Reset Graphics. 

26. Закрыть приложение MSC.Laminate Modeler. 

В диалоговой панели нажимаем кнопку Close, а затем в окне инициализа-

ции – Cancel. 

27. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Следует отметить, что в последних версиях системы MSC.Patran-Nastran 

по умолчанию установлена опция распределения результатов по глобаль-

ным слоям. Для оценки прочности композитной конструкции её следует 

отключить. 

Нажимаем кнопку Translation Parameters и снимаем флаг «Write Global 

Ply IDs», OK. 

Для запуска задачи на счёт нажимаем кнопку Apply основной диалоговой 

панели приложения. 

Появляющиеся здесь сообщения закрываем кнопкой Yes. 

28. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

clab4.xdb, OK. 

В заключение нажимаем Apply. 

29. Создать новый случай результатов, содержащий рассчитанные значения 

критерия разрушения. 
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В полосе меню выбираем команду Tools>Laminate Modeler>Laminate. 

При этом справа появляется диалоговая панель, где устанавливаем соче-

тание Create/Results/Failure Calc. 

В списке «Select Results Cases» указываем единственный случай результа-

тов, а в списке «Select Layered Result» – Stress Tensor. 

Далее активизируем поле «Select Area» и в графическом окне зоной выбо-

ра в виде прямоугольника охватываем всю модель. 

В выпадающем меню «Criterion» в качестве критерия разрушения выбира-

ем Tsai-Wu. 

В поле «Name» вводим имя набора результатов, например new. 

Нажимаем Apply. 

В конце кнопкой Close закрываем диалоговую панель «Composite 

Modeler». 

30. Оценить прочность композитной пластины. 

Запускаем приложение «Results» и устанавливаем сочетание Create/Quick 

Plot. 

В списке «Select Result Cases» выбираем второй случай результатов. 

В списке «Select Fringe Result» указываем строку Margins of Safety 

(Worst)*, Tsai-Wu Stress (new). 

Нажимаем Apply. 

Отображаемые при этом результаты будут практически полностью совпа-

дать с полученными ранее значениями (см. рисунок 4.5). 

31. Выйти из программы: File>Quit. 

 



 33

ЛАБОРАТОРНАЯ  РАБОТА  № 5 

«Моделирование композитной конструкции  
с неравномерным распределением слоёв» 

 

Исходные данные: прямоугольная полимерная пластина, армированная 

короткими волокнами (со случайной ориентацией в плоскости пластины), 

шарнирно опёрта по контуру и нагружена равномерным давлением 

0,1p = МПа (рисунок 5.1). Упругие свойства полимерной матрицы: 
35,2 10mE = ⋅ МПа  и 0,3mν = . Упругие свойства волокна: 51,1 10fE = ⋅ МПа  и 

0,28fν = . Объёмная доля волокон 0,3fV = . Отношение длины волокна к  

его диаметру 20l d = . Угол ориентации волокон θ  (отсчитываемый от про-

дольной оси X ) подчиняется нормальному закону распределения со сле-

дующими параметрами: av 0θ =  и 10θσ = ° . Толщина пластины равна 2 мм. 

Рассматриваемая конструкция в продольном и поперечном направлениях 

усилена слоями, армированными тканью и имеющими следующие характе-

ристики: 4
1 3,4 10E = ⋅ МПа; 4

2 2,5 10E = ⋅ МПа; 3
12 3,3 10G = ⋅ МПа; 12 0,15µ = . 

Толщина каждого слоя составляет 0,25 мм. 

Цель: исследовать распределение напряжений в локальных и глобаль-

ных слоях композитной конструкции. 

Итоговая информация по слоям сведена в таблицу 5.1. 

 

 
Рисунок 5.1 – Конструкция с неравномерным распределением слоёв 
 

 

X  

Y  

Z  

300 

150 

1 – полимерная пластина с короткими волокнами 

2 – слои ткани 0/90/0 

3 – слои ткани 45/0/-45 
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Таблица 5.1 – Данные по слоям 

№ слоя Толщина, мм Угол ориентации, град 
1 1 2 0 

1 0,25 0 
2 0,25 90 2 
3 0,25 0 
1 0,25 45 
2 0,25 0 3 
3 0,25 -45 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить MSC.Patran и открыть новую базу данных: File>New. 

В поле «File name» указываем имя файла базы данных Clab5.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» и в поле «Model Dimension» вводим значе-

ние 300 (в мм), OK. 

3. Построить прямоугольную поверхность. 

Выбираем приложение «Geometry» и устанавливаем сочетание Create/ 

Surface/XYZ. 

В соответствующие поля вводим: 

 «Vector Coordinates List»: <300 150 0> (описывающий диагональ век-

тор, мм) 

 «Origin Coordinate List»: [0 0 0] (координаты начала вектора, мм) 

Apply. 

4. Разбить поверхность на конечные элементы. 

Запускаем приложение «Elements» и устанавливаем сочетание Create/ 

Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad (четырёхугольная форма) 

 «Mesher»: IsoMesh (генератор регулярных изосеток) 

 «Topology»: Quad4 (топология – четырёхугольник с четырьмя узлами). 

Активизируем поле «Surface List» и в графическом окне указываем по-

верхность 1. 

В разделе «Global Edge Length» отключаем опцию автоматического вы-

числения глобальной длины стороны элемента и в поле «Value» вводим 

значение 10 (в мм). Apply. 

5. Задать упругие свойства полимерной матрицы. 
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Запускаем приложение «Materials» и для задания свойств изотропного ма-

териала выбираем сочетание Create/Isotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например matrix. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства поли-

мерной матрицы: 

 «Elastic Modulus» = 5.2e3 (модуль упругости, МПа) 

 «Poisson Ratio» = 0.3 (коэффициент Пуассона) 

OK. 

Нажимаем кнопку Apply. 

6. Задать упругие свойства волокна. 
В поле «Material Name» вводим другое имя материала, например fiber. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства во-

локна: 

 «Elastic Modulus» = 1.1e5 (модуль упругости, МПа) 

 «Poisson Ratio» = 0.28 (коэффициент Пуассона) 

OK. 

Нажимаем кнопку Apply. 

7. Построить модель двухфазного композита Халпина-Цая, армированного 
разорванными волокнами. 

В приложении «Materials» устанавливаем сочетание Create/Composite/ 

HAL Disc. Fiber. 

Сначала в основной диалоговой панели приложения в поле «Material 

Name» вводим имя композита, например disc_fiber. 

Затем здесь же в списке существующих материалов «Existing Materials» 

указываем сначала fiber, а затем matrix. Это приводит к заполнению полей 

«Fiber» (волокно) и «Matrix» (матрица) дополнительной панели. 

В поле «Fiber Volume Fraction» (объёмная доля волокон) вводим значение 

0.3, а в «Matrix Volume Fraction» (объёмная доля матрицы) – 0.7. 

И наконец, в поле «Fiber Aspect Ratio (l/d)» (отношение длины волокна к 

его диаметру) вводим число 20. 

Для завершения данной операции нажимаем кнопку Apply основной пане-

ли приложения. 

Для просмотра упругих свойств полученного композита следует восполь-

зоваться кнопкой  Show Material Properties. При этом если активизировать 

опцию «E’s, NU’s, G’s, and Qij’s», то в первом столбце выводимой табли-

цы будут показаны эффективные (осреднённые) модули упругости мате-
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риала в каждом из трёх его главных направлений, во втором – коэффици-

енты Пуассона в трёх взаимно перпендикулярных плоскостях, а в третьем 

– модули сдвига в тех же плоскостях. В конце приводится матрица упру-

гих постоянных для случая обобщённого плоского напряжённого состоя-

ния (размером 3х3). 

Можно заметить, что коэффициент Пуассона в плоскости изотропии при-

нимает недопустимо большое значение, равное 0,763. Выясним, с чем это 

связано. 

Для модели композита с разорванными волокнами основные упругие по-

стоянные находятся с помощью уравнений правила смесей и Халпина-Цая 

с использованием эмпирических констант. В рассматриваемом случае 

константы принимают следующие значения: 

L T LT LT TT
400; 2; 1; 1; 0,323.E E G Gνξ ξ ξ ξ ξ= = = = =  

Коэффициент Пуассона в плоскости изотропии является производной ве-

личиной, определяемой через TE  и TTG . Он получается слишком большим 

из-за того, что 
TTGξ  много меньше 

TEξ . Таким образом, формулу для по-

стоянной 
TTGξ  следует признать некорректной. 

Этот недостаток можно устранить путём переопределения эмпирических 

констант. 

Закрываем окно «Composite Material Properties» кнопкой Cancel. 

Устанавливаем флаг «Override Default Equation» и в соответствующие по-

ля вводим: 

 «E(L)»: 400 

 «E(T)»: 2 

 «NU(LT)»: 1 

 «G(LT)»: 1 

 «G(TT)»: 2 (новое значение). 

Снова нажимаем кнопку Apply основной панели приложения. Подтвер-

ждаем переопределение модели материала, закрывая окно с сообщением 

кнопкой Yes. 

Отметим, что новое значение коэффициента Пуассона в плоскости изо-

тропии равно 0,298. 

8. Построить модель композита со случайной ориентацией коротких волокон 

в одной плоскости. 



 37

В том же приложении устанавливаем сочетание Create/Composite/Short  

Fiber 1D. 

В поле «Material Name» вводим имя композиционного материала, напри-

мер random_fiber. 

В списке существующих материалов «Existing Materials» в качестве ис-

ходного однонаправленного композита указываем disc_fiber. 

По умолчанию математическое ожидание угла ориентации равно 0, а 

среднее квадратическое отклонение – 10°. Оставляем эти параметры без 

изменения. Apply. 

Для просмотра упругих свойств полученного композита нажимаем кнопку 

Show Material Properties и включаем опцию «E’s, NU’s, G’s, and Qij’s» (ри-

сунок 5.2). Cancel. 

 

 
Рисунок 5.2 – Эффективные упругие свойства композита 

 

9. Построить модель однородного материала для полимерной пластины. 

Следует отметить, что при создании LM-материалов в качестве исходных 

можно выбирать только однородные материалы. Поэтому необходимо оп-

ределить новый однородный материал, обладающий теми же интеграль-

ными свойствами, что и композит со случайной ориентацией коротких во-

локон. 

Ограничимся здесь выбором двухмерного анизотропного материала, для 

чего устанавливаем сочетание Create/2d Anisotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например plate. 

Далее нажимаем кнопку Input Properties и вводим коэффициенты матрицы 

упругих постоянных Q (см. рисунок 5.2): 
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 «Stiffness 11» = 2.84e4 (МПа) 

 «Stiffness 12» = 3.81e3 (МПа) 

 «Stiffness 13» = -7.7e1 (МПа) 

 «Stiffness 22» = 1.11e4 (МПа) 

 «Stiffness 23» = 3.48 (МПа) 

 «Stiffness 33» = 4.06e3 (МПа) 

OK. 

Нажимаем кнопку Apply. 

10. Построить модель двухмерного ортотропного материала для слоёв, арми-

рованных тканью. 

Устанавливаем сочетание Create/2d Orthotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например fabric. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 3.4e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 2.5e4 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.15 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 3.3e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 3.3e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 3.3e3 (модуль сдвига 13G , МПа) 

OK. 

Нажимаем Apply. 

11. Открыть новую базу данных в MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab5.Layup, OK. 

12. Создать LM-материалы. 

В выпадающих меню приложения MSC.Laminate Modeler выбираем соче-

тание Create/LM_Material/Add. 

Используем установленный по умолчанию тип материала Drape (Scissor) – 

драпированный раскроем. 

Сначала для полимерной пластины в списке «Analysis Materials» указыва-

ем материал plate и в поле «Thickness» вводим значение толщины  

(в мм): 2. Остальные параметры оставляем без изменения. Apply. 
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Материал с именем Mat_1 должен появиться в списке «Existing 

LM_Materials». 

Аналогично создаём LM-материал с именем Mat_2 для слоёв, армирован-

ных тканью. При этом в качестве исходного материала указываем fabric, а 

для толщины вводим значение 0.25 (в мм). 

В конце также нажимаем кнопку Apply. 

13. Создать LM-слои. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Используем «Type»: Drape (Scissor). 

Для первого LM- слоя в списке «Select LM_Material» выбираем материал 

Mat_1. 

Активизируем поле «Select Area» и в графическом окне в качестве облас-

ти, покрываемой слоем, указываем всю поверхность (Surface 1). 

За начальную точку принимаем левую нижнюю вершину поверхности, т.е. 

«Start Point»: Point 1. 

Далее вводим: 

 «Application Direction»: <0. 0. -1.> (направление прикладывания) 

 «Reference Direction»: Coord 0.1 (базовое направление) 

 «Reference Angle»: 0 (базовый угол) 

Apply. 

Слой с именем Ply_1 должен появиться в списке «Existing LM_Plys». 

Для удаления с экрана результатов драпировки нажимаем кнопку    до-

полнительной панели инструментов, управляющей изображением слоёв. 

Для второго LM- слоя (так же как и для всех последующих) в списке «Se-

lect LM_Material» выбираем материал Mat_2. 

Активизируем поле «Select Area», в пиктографическом меню выбора на-

жимаем кнопку     (оболочечный элемент) и в графическом окне мышью 

вытягиваем прямоугольник выбора так, чтобы он охватил средние в попе-

речном направлении элементы (рисунок 5.3).  

Для поля «Start Point» указываем узел 156 (Node 156). 

Apply. 

Для третьего LM- слоя меняем только базовый угол, т.е. «Reference 

Angle»: 90. 

И наконец, в качестве области определения трёх последних слоёв указы-

ваем средние в продольном направлении элементы (рисунок 8.4). 

 



 40

 
Рисунок 5.3 – Выбор элементов для слоёв продольного усиления 

 

 
Рисунок 5.4 – Выбор элементов для слоёв поперечного усиления 

 

За начальную точку выбираем узел 11 (Node 11). 

Для четвёртого LM- слоя в качестве базового угла в поле «Reference An-

gle» вводим значение 45 (в градусах), для пятого – значение 0 и для шес-
того – отрицательное значение -45. 

Ввод каждого слоя завершаем нажатием кнопки Apply. 

Информация по всем LM-слоям представлена в таблице 5.2. 

 
Таблица 5.2 – Данные по LM- слоям 

LM_Ply Name Select Area Start Point Reference Angle 
Ply_1 Surface 1 Point 1 0 
Ply_2 0 
Ply_3 

Elm 151:300 Node 156 
90 

Ply_4 45 
Ply_5 0 
Ply_6 

Elm 11:20 41:50 71:80 
... 251:260 281:290 

Node 11 
-45 

 

14. Создать LM-пакет. 

Устанавливаем сочетание Create/LM_Layup/Add. 

Node 156 

Node 11 
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Нажимаем кнопку Layup Definition (определение пакета). 

При этом появляется дополнительное окно, где из списка «Existing 

LM_Plys» выбираем соответствующие слои как показано на рисунке 5.5. 

 

 
Рисунок 5.5 – Определение LM- пакета 

 

После заполнения таблицы нажимаем OK. 

Расположим отсчётную (узловую) плоскость посредине толщины поли-

мерной пластины. Для этого нажимаем кнопку Offset Definition (определе-

ние отступов). 

Выбираем режим «Define Offsets». 

Выделяем первую строку таблицы «Define Offsets» и в соответствующие 

поля вводим: 

 «Select Area»: Surface 1 (выбор области) 

 «Definition Point»: Point 1 (определяющая точка) 

 «Definition Direction»: <0. 0. -1.> (определяющее направление взгляда) 

 «Offset Value»: 1 (значение отступа, мм) 

 «Offset Flag»: Top (признак отступа) 

Create. 

В первой строке таблицы должна появиться запись Surface 1. 

Нажимаем последовательно  OK и  Apply. 

При этом появится информационное окно с сообщением: The analysis 

model will require 4 properties referencing 4 laminates, 0 materials, 0 coordi-

nates and 1 fields for the selected tolerance. Do you wish to continue? (Модель 

для анализа в соответствии с выбранной точностью требует создания 4 

наборов свойств элементов, ссылающихся на 4 слоистых материала, 0 од-

нородных материалов, 0 систем координат и 1 поле. Вы хотите продол-

жить?). 

Нажимаем Yes. 

15. Проверить созданную модель. 
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Для изображения пакета с прорисовкой толщин слоёв устанавливаем со-

четание Show/Laminate. 

Для поля «Select Area» указываем все элементы (Elm 1:450). 

В списке существующих свойств выделяем строку Thickness (толщина). 

Бегунок «Thickness Scale» (масштаб толщины) перемещаем в крайнее пра-

вое положение. Apply. 

Получаемое здесь изображение показано на рисунке 5.6 (где в соответст-

вии с заданным масштабом толщины слоёв увеличены в 10 раз). 

 

 
Рисунок 5.6 – Изображение модели с прорисовкой толщин слоёв 

 

Для восстановления предыдущего вида нажимаем кнопку Reset Graphics. 

Чтобы проверить последовательность укладки слоёв, выбираем сочетание 

Show/LM_Layup/Exploded View. 

Нажимаем кнопку Set Labels (установить метки). 

Вместо «LM_Layup Name» устанавливаем флаги «LM_Ply Name» и «Ref-

erence Angle», OK. 

Для выбора всех слоёв нажимаем кнопку Select All. 

Бегунок «Offset Dist. Multiplier» (множитель расстояния между слоями) 

сдвигаем до конца вправо. 

Apply. 

При этом в графическом окне появится изображение глобальных слоёв в 

«разобранном» виде (рисунок 5.7). 

Для возвращения к предыдущему виду также нажимаем Reset Graphics. 

16. Закрыть приложение MSC.Laminate Modeler. 

В диалоговой панели нажимаем кнопку Close, а затем в окне инициализа-

ции – Cancel. 
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Рисунок 5.7 – Изображение глобальных слоёв в «разобранном» виде 

 

17. Задать граничные условия. 
Напомним, что в рассматриваемой задаче пластина шарнирно опёрта по 

всему контуру. 

Запускаем приложение «Loads/BCs» и для задания перемещений устанав-

ливаем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя нового набора, например hinge. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,0,0>, OK. 

Нажимаем Select Application Region. Для выбора геометрических объектов 

используем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (кривая или кромка) и указываем все четыре 

кромки поверхности, предварительно нажав клавишу Shift. 

Последовательно нажимаем кнопки Add, OK и Apply. 

18. Приложить нагрузку. 
Для задания давления в том же приложении выбираем сочетание Create/ 

Pressure/Element Uniform. 

В поле «New Set Name» вводим имя нового набора, например load. 

В качестве типа целевых элементов выбираем поверхностные, т.е. «Target 

Element Type»: 2D. 
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Нажимаем кнопку Input Data и в поле «Top Surf Pressure» (давление на 

верхней поверхности) вводим значение 0.1 (в МПа). OK. 

Далее нажимаем кнопку Select Application Region. Используем опцию «Se-

lect»: Geometry. 

Активизируем поле «Select Surfaces or Edges», в пиктографическом меню 

выбора нажимаем кнопку      (поверхность или грань) и указываем по-

верхность 1. 

Последовательно нажимаем кнопки Add, OK и  Apply. 

19. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Следует отметить, что в последних версиях системы MSC.Patran-Nastran 

по умолчанию установлена опция распределения результатов по глобаль-

ным слоям. Её следует отключить, поскольку нас интересует распределе-

ние напряжений как в глобальных, так и в локальных слоях. 

Для изменения параметров, используемых при передаче данных, нажима-

ем кнопку Translation Parameters и снимаем флаг «Write Global Ply IDs». 

OK. 

Для запуска задачи на счёт нажимаем кнопку Apply основной диалоговой 

панели приложения. 

20. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

сlab5.xdb, OK. 

В заключение нажимаем Apply. 

21. Снова запустить приложение MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

Попадаем в окно инициализации, где с помощью кнопки Open Layup File 

открываем базу данных с именем Clab5.Layup, OK. 

22. Сортировать результаты в соответствии с глобальными слоями. 

Устанавливаем сочетание Create/Results/LM_Ply_Sort. 

В списке имеющихся случаев результатов «Select Result Cases» выделяем 

строку Default, A1: Static Subcase. 
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Ниже в списке рассчитанных в слоях результатов «Select Layered 

Result(s)» указываем Stress Tensor (тензор напряжений). 

Нажимаем Apply. 

Последовательно нажимая кнопки Close и Cancel, закрываем приложение 

MSC.Laminate Modeler. 

23. Изобразить поля напряжений по Мизесу в локальных и глобальных слоях. 

Запускаем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 

В списке «Select Result Cases» должны находиться два случая результатов, 

причём первый случай будет содержать напряжения, распределённые по 

локальным слоям, а второй – по глобальным слоям. 

Для изображения поля напряжений в локальных слоях выделяем первый 

случай результатов и в списке «Select Fringe Result» указываем строку 

Stress Tensor. 

Нажимаем расположенную ниже кнопку Position и выбираем конкретный 

локальный слой Layer n (где n – номер слоя). Close. 

Используем «Quantity»: von Mises (напряжение по Мизесу). Apply. 

Для изображения поля напряжений в глобальных (физических) слоях вы-

деляем второй случай результатов и в списке «Select Fringe Result» указы-

ваем строку LM_Sort, All Global Plies, MSC.Nastran, Stress Tensor. 

С помощью кнопки Position выбираем конкретный глобальный слой At 

Clab2.n (где n – номер слоя). Close и Apply. 

На рисунке 5.8 показано отличие распределения напряжений в локальных 

слоях от распределения в глобальных слоях. 

24. Выйти из программы: File>Quit. 
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Рисунок 5.8 – Изображение полей напряжений по Мизесу (МПа) 
в локальных (а, в) и глобальных (б, г) слоях 

 

а) локальный слой 2 б) глобальный слой 2 

в) локальный слой 5 г) глобальный слой 5 
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ЛАБОРАТОРНАЯ  РАБОТА  № 6 

«Драпировка поверхности двойной кривизны» 

 

Исходные данные: выкладка различных слоёв производится на седло-

видную поверхность, полученную вращением параболы вокруг прямолиней-

ной оси на угол 180° (рисунок 6.1). Слой, армированный тканью, обладает 

следующими упругими свойствами: 4
1 4,5 10E = ⋅ МПа; 4

2 3,8 10E = ⋅ МПа; 

12 0,12µ = ; 3
12 3,5 10G = ⋅ МПа; 3

23 4,0 10G = ⋅ МПа; 3
13 4,0 10G = ⋅ МПа. Упругие 

свойства однонаправленного слоя: 4
1 16,4 10E = ⋅ МПа; 3

2 9,7 10E = ⋅ МПа; 

12 0,28µ = ; 3
12 5,1 10G = ⋅ МПа; 3

23 3,8 10G = ⋅ МПа; 3
13 5,1 10G = ⋅ МПа. В обоих 

случаях исходная толщина слоя составляет 0,2 мм, а максимально допусти-

мая деформация сдвига в процессе драпировки равна 60°. 

Цель: исследовать выкладку различных слоёв на неразвёртывающуюся 

поверхность с отрицательной гауссовой кривизной; оценить влияние вход-

ных параметров (таких как начальная точка, базовый угол и т.п.) на распре-

деление деформаций сдвига, возникающих в процессе драпировки. 

 

 
Рисунок 6.1 – Геометрия поверхности формы 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить MSC.Patran и открыть новую базу данных: File>New. 

В поле «File name» указываем имя файла базы данных Clab6.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» и в поле «Model Dimension» вводим значе-

ние 200 (в мм), OK. 

3. Построить точки, лежащие на параболе, согласно следующей таблице: 

X  

Y  

200 

R
10

0 

R
50
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Номер  
точки 

X, 
мм 

Y, 
мм 

Z, 
мм 

Ввод 

1 -100 100 0 [-100 100 0] 
2 0 50 0 [0 50 0] 
3 100 100 0 [100 100 0] 

 

Выбираем приложение «Geometry» и для ввода точек по их координатам 

устанавливаем сочетание Create/Point/XYZ. 

В поле «Point Coordinate List» последовательно вводим координаты точек 

в квадратных скобках, как показано в последнем столбце таблицы. Каж-

дый ввод завершаем нажатием кнопки Apply. 

4. Построить параболу, проходящую через три заданные точки. 

Устанавливаем сочетание Create/Curve/Point. 

В меню «Option» выбираем опцию 3 Point (по трём точкам). 

Включаем опцию «Chord Length» (длина хорды). 

Вводим: 

 «Starting Point List»: Point 1 (начальная точка) 

 «Middle Point List»: Point 2 (средняя точка) 

 «Ending Point List»: Point 3 (конечная точка) 

Apply. 

5. Разбить параболу на две равные части. 

Устанавливаем сочетание Edit/Curve/Break. 

В меню «Option» выбираем опцию Parametric (параметрическое задание 

точки разбиения). 

Для поля «u Parametric Value» (значение параметрической координаты) 

используем значение 0.5, задаваемое по умолчанию. 

Для удаления исходных кривых устанавливаем флаг «Delete Original 

Curves». 

Для поля «Curve List» указываем Curve 1. 

Если требуется, нажимаем Apply и кнопкой Yes подтверждаем удаление 

исходных кривых. 

6. Построить поверхность вращением параболы вокруг прямолинейной оси. 

Устанавливаем сочетание Create/Surface/Revolve. 

В соответствующие поля вводим: 

 «Refer. Coordinate Frame»: Coord 0 (базовая система координат) 

 «Axis»: Coord 0.1 (ось вращения – ось X) 

 «Total Angle»: 90 (полный угол, град) 
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 «Offset Angle»: 0 (отступ угла, град) 

 «Curve List»: Curve 2 3 (список кривых) 

Apply. 

С помощью кнопки Iso 3 View панели инструментов меняем проекцию. 

7. Создать зеркальное отображение поверхностей. 

Устанавливаем сочетание Transform/Surface/Mirror. 

В нашем случае плоскость зеркала совпадает с глобальной плоскостью XY, 

поэтому в поле «Define Mirror Plane Normal» (определение нормали к 

плоскости зеркала) вводим Coord 0.3. 

Поскольку исходные поверхности удалять не следует, флаг «Delete Origi-

nal Surfaces» должен быть снят. 

Для поля «Surface List» указываем обе поверхности (Surface 1 2). 

При необходимости нажимаем Apply. 

8. Разбить поверхности на конечные элементы. 

Запускаем приложение «Elements» и устанавливаем сочетание Create/ 

Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad (четырёхугольная форма) 

 «Mesher»: IsoMesh (генератор регулярных изосеток) 

 «Topology»: Quad4 (топология – четырёхугольник с четырьмя узлами). 

Активизируем поле «Surface List» и в графическом окне указываем все 

поверхности (Surface 1:4). 

В разделе «Global Edge Length» отключаем опцию автоматического вы-

числения глобальной длины стороны элемента и в поле «Value» вводим 

значение 10 (в мм). Apply. 

Получаемая при этом разбивка показана на рисунке 6.2. 

9. Сшить конечно-элементную модель. 

Устанавливаем сочетание Equivalence/All/Tolerance Cube. 

Ничего не меняя, нажимаем Apply. При этом места сшивки модели будут 

обведены кружочками. 

10. Построить модель двухмерного ортотропного материала для слоёв, арми-

рованных тканью. 

Запускаем приложение «Materials» и для задания свойств двухмерного ор-

тотропного материала выбираем сочетание Create/2d Orthotropic/Manual 

Input. 

В поле «Material Name» вводим имя материала, например fabric. 
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Рисунок 6.2 – Конечно-элементная модель 

 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 4.5e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 3.8e4 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.12 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 3.5e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 4e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 4e3 (модуль сдвига 13G , МПа) 

OK. 

Нажимаем Apply. 

11. Построить модель двухмерного ортотропного материала для однонаправ-
ленных слоёв. 

В поле «Material Name» вводим имя материала, например unidir. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 16.4e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 9.7e3 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.28 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 5.1e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 3.8e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 5.1e3 (модуль сдвига 13G , МПа) 

OK. 

Нажимаем Apply. 

12. Открыть новую базу данных в MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 
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В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab6.Layup, OK. 

13. Создать LM-материалы. 

В выпадающих меню приложения MSC.Laminate Modeler выбираем соче-

тание Create/LM_Material/Add. 

Для первого LM-материала, армированного тканью, используем установ-

ленный по умолчанию тип Drape (Scissor) – драпированный раскроем. 

В списке «Analysis Materials» указываем материал fabric и в поле «Thick-

ness» вводим значение толщины (в мм): 0.2. Остальные параметры остав-

ляем без изменения. Apply. 

Материал с именем Mat_1 должен появиться в списке «Existing 

LM_Materials». 

Поскольку второй LM-материал является однонаправленным, для него 

выбираем тип Drape (Slide) – драпированный скольжением. 

В качестве исходного материала здесь указываем unidir. Остальные пара-

метры оставляем без изменения. Apply. 

14. Создать первый LM-слой. 

Здесь полезно предварительно убрать с экрана изображение конечно-

элементных объектов. С этой целью выбираем в полосе меню команду 

Display>Plot/Erase и в подразделе «FEM» нажимаем кнопку Erase (сте-

реть). Отметим, что расположенная рядом кнопка Plot позволяет снова 

включить отображение данных объектов. 

Для закрытия диалоговой панели нажимаем OK. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Используем «Type»: Drape (Scissor). 

В списке «Select LM_Material» выбираем материал Mat_1. 

С помощью кнопки Top view панели инструментов устанавливаем вид 

сверху, т.е. на плоскость XZ. 

Активизируем поле «Select Area» и в графическом окне в качестве облас-

ти, покрываемой слоем, указываем все поверхности (Surface 1:4). 

За начальную принимаем центральную точку формы, т.е. «Start Point»: 

Point 2. 

Далее вводим: 

 «Application Direction»: View (направление прикладывания) 

 «Reference Direction»: Coord 0.1 (базовое направление) 

 «Reference Angle»: 0 (базовый угол). 
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Следует отметить, что направление прикладывания можно задавать по-

разному: Manual – вручную; Normal – по нормали к поверхности; View – в 

направлении взгляда, т.е. перпендикулярно плоскости экрана. 

Для задания дополнительных параметров нажимаем кнопку Additional 

Controls. 

В разделе «Control Parameters» активизируем опцию Geometry (параметры, 

определяющие алгоритм глобальной выкладки). 

Выбираем: 

 «Axis Type»: Geodesic (тип осей – геодезический) 

 «Extension Type»: Geodesic (тип распространения – геодезический) 

OK. 

Apply. 

Слой с именем Ply_1 должен появиться в списке «Existing LM_Plys». 

Отображаемые в графическом окне модель драпировки и выкройка для 

первого LM-слоя показаны на рисунке 6.3. 

 

 
Рисунок 6.3 – Изображение первого LM- слоя 

 

Поскольку в нашем случае форма представляет собой неразвёртываю-

щуюся поверхность, деформация сдвига начинает нарастать сразу при 

удалении от начальной точки и главных осей материала, в качестве кото-

рых были выбраны геодезические линии. 

Следует напомнить, что на синих участках деформация ткани не превы-

шает 50% от максимально допустимого значения; на жёлтых – деформа-

ция ткани находится в пределах 50...100%; на красных – деформация пре-

вышает максимально допустимую. 
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Как видно из рисунка 6.3, наибольшая по абсолютной величине деформа-

ция сдвига составляет 60,6°, что немного превышает максимально допус-

тимое для данного материала значение. Это может привести к образова-

нию морщин и складок. 

Заметим также, что толщина данного слоя меняется от 0,2 до 0,41 мм. 

Для редактирования графического изображения слоёв здесь можно вос-

пользоваться дополнительной панелью инструментов, которая появляется 

автоматически. Она позволяет отобразить либо скрыть стрелки, показы-

вающие направление прикладывания и базовое направление, границу и 

контур выбранной области, модель драпировки, выкройку, надпись, стрел-

ки, показывающие направление нитей основы и утка в отдельных элемен-

тах, а также материал, из которого сделан слой. 

Для полного удаления с экрана всех результатов драпировки нажимаем 

кнопку      дополнительной панели инструментов. 

Следует отметить, что имитация драпировки представляет собой нелиней-

ный дискретный процесс. Уменьшая размер шага, здесь можно повысить 

точность получаемых результатов. Однако, если шаг является слишком 

мелким, то может не хватить ресурсов компьютера для покрытия всей об-

ласти. 

Размер шага задаётся в разделе «Step Length» диалоговой панели «Addi-

tional Controls». Здесь можно, используя опцию «Implicit», ввести множи-

тель для длины шага, рассчитываемой по умолчанию на основе площади 

рассматриваемой области, либо, выбрав опцию «Explicit», ввести абсо-

лютный размер шага (в мм). 

Если Вы построили дополнительные LM-слои, удалите их, установив со-

четание Delete/LM_Ply/Select. 

15. Создать второй LM-слой. 

В списке «Select LM_Material» также выделяем материал Mat_1. 

Нажимаем кнопку Additional Controls. 

Выбираем: 

 «Axis Type»: None (главные оси не задаются) 

 «Extension Type»: Energy (тип распространения – энергетический) 

OK. 

Apply. 

Следует отметить, что данный тип распространения хорошо моделирует 

ручную выкладку ткани на поверхность формы. 
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Получаемое при этом изображение слоя представлено на рисунке 6.4. 

 

 
Рисунок 6.4 – Изображение второго LM- слоя 

 

Можно заметить, что наибольшая по абсолютной величине деформация 

сдвига по сравнению с первым слоем здесь заметно уменьшилась и со-

ставляет 49,7°. При этом существенно изменилась и конфигурация вы-

кройки. 

16. Создать третий LM-слой. 

Опять в списке «Select LM_Material» выделяем материал Mat_1. 

Меняем только базовый угол, т.е. «Reference Angle»: 30. 

Apply. 

Можно заметить, что главная ось основы материала поворачивается на за-

данный угол, отсчитываемый от базового направления против хода часо-

вой стрелки, если смотреть вдоль вектора направления прикладывания. 

Наибольшая по абсолютной величине деформация сдвига здесь равна 

49,5°. 

Вследствие нелинейности процесса драпировки угол ориентации данного 

слоя в отдельных элементах будет не обязательно равен 30°. 

17. Создать четвёртый LM-слой. 

Выбираем «Type»: Drape (Slide). 

В списке «Select LM_Material» выделяем однонаправленный материал 

Mat_2. 

Остальные параметры оставляем без изменения кроме базового угла, ко-

торый зададим равным 45°. 
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Apply. 

Результаты драпировки представлены на рисунке 6.5 

 

 
Рисунок 6.5 – Изображение четвёртого LM- слоя 

 

18. Создать пятый LM-слой. 

По сравнению с предыдущим случаем в качестве начальной выберем не 

центральную, а угловую точку поверхности формы. 

В списке «Select LM_Material» выделяем материал Mat_2. 

Далее вводим: 

 «Start Point»: Point 4  

 «Application Direction»: Normal (по нормали к поверхности) 

 «Reference Direction»: Coord 0.1  

 «Reference Angle»: 45 

Apply. 

Для данного слоя наибольшая по абсолютной величине деформация сдви-

га составляет 71,9°, что значительно превышает максимально допустимое 

значение. Образование морщин и складок здесь неизбежно. Это связано с 

тем, что при удалении начальной точки от центра рассматриваемой облас-

ти увеличивается максимальное расстояние от начальной точки до границ 

области. А чем больше данное расстояние, тем сильнее может деформиро-

ваться ткань в процессе выкладки на неразвёртывающуюся поверхность 

формы. 

19. Закрыть приложение MSC.Laminate Modeler. 
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В диалоговой панели нажимаем кнопку Close, а затем в окне инициализа-

ции – Cancel. 

20. Выйти из программы: File>Quit. 
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ЛАБОРАТОРНАЯ  РАБОТА  № 7 

«Моделирование композитного обтекателя,  
изготавливаемого методом выкладки слоёв» 

 

Исходные данные: обтекатель представляет собой многослойную обо-

лочку, состоящую из сферического носка и конического участка (рису-

нок 7.1). Он изготавливается путём выкладки на позитивную (выпуклую) 

форму различных выкроек ткани, охватывающих разные области поверхно-

сти обтекателя. Так, первый слой покрывает всю поверхность обтекателя. 

Второй и третий слои – только конический участок, причём их швы разнесе-

ны. Четвёртый и пятый слои – противоположные половины обтекателя. За-

тем точно такие же слои выкладываются в обратном порядке так, чтобы 

структура пакета была симметричной. Характеристики слоя, армированного 

тканью: 4
1 2,8 10E = ⋅ МПа; 4

2 1,9 10E = ⋅ МПа; 3
12 3,1 10G = ⋅ МПа; 12 0,14µ = ; 

1в 500σ + = МПа; 1в 260σ − = − МПа; 2в 320σ + = МПа; 2в 180σ − = − МПа; 12в 35σ = МПа. 

Исходная толщина слоя составляет 0,3 мм. Максимально допустимая дефор-

мация сдвига в процессе драпировки равна 65°. 

 

 
Рисунок 7.1 – Геометрия обтекателя 

 

Нагружение обтекателя осуществляется аэродинамическим давлением, 

которое в рассматриваемом расчётном случае на сферическом участке посто-

янно и составляет 0,06 МПа, а на коническом – изменяется по следующему 

закону: 

X  

Z  

Y  

1000∅  

11
50

 

R150 
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где ϕ  – окружная (угловая) координата, отсчитываемая от оси X  в направ-

лении оси Y . Настоящая конструкция жёстко закреплена по нижнему осно-

ванию по всем степеням свободы. 

Цель: исследовать процесс выкладки слоёв ткани на поверхность с не-

нулевой гауссовой кривизной; оценить устойчивость и прочность обтекателя. 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить MSC.Patran и открыть новую базу данных: File>New. 

В поле «File name» указываем имя файла базы данных Clab7.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» и в поле «Model Dimension» вводим значе-

ние 1150 (в мм), OK. 

3. Построить дугу окружности, представляющую носок. 

Запускаем приложение «Geometry» и устанавливаем сочетание Create/ 

Curve/Arc3Point. 

В соответствующие поля вводим: 

 «Starting Point List»: [0 0 1150] (координаты начальной точки, мм) 

 «Middle Point List»: [150 0 1000] (координаты средней точки, мм) 

 «Ending Point List»: [0 0 850] (координаты конечной точки, мм) 

Apply. 

С помощью кнопки Bottom view панели инструментов устанавливаем вид 

на плоскость XZ . 

4. Построить образующую конуса, касательную к дуге. 

Выбираем сочетание Create/Curve/TanPoint. 

Используем установленную по умолчанию опцию «Trim Original Curves» 

(подрезать исходные кривые). 

В поле «Point List» вводим координаты точки, из которой будет прово-

диться касательная (в мм): [500 0 0]. 

Далее активизируем поле «Curve List» и указываем кривую 1 (Curve 1). 

При необходимости нажимаем кнопку Apply.  

Здесь появится информационное окно с сообщением: Do you wish to trim 

the original curve 1? (Вы хотите подрезать исходную кривую 1?). 

Нажимаем Yes. 
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5. Построить две поверхности вращения. 

Для создания поверхности вращением кривой вокруг заданной оси уста-

навливаем сочетание Create/Surface/Revolve. 

В соответствующие поля вводим: 

 «Refer. Coordinate Frame»: Coord 0 (базовая система координат) 

 «Axis»: Coord 0.3 (ось вращения – ось Z) 

 «Total Angle»: 90 (полный угол, град) 

 «Offset Angle»: 0 (отступ угла, град) 

 «Curve List»: Curve 1 2 (список кривых) 

Apply. 

С помощью кнопки Iso 3 View панели инструментов меняем проекцию. 

6. Создать копии поверхностей. 

Для вращения поверхности вокруг заданной оси в выпадающих меню 

приложения «Geometry» устанавливаем сочетание Transform/Surface/  

Rotate. 

Проверяем, что флаг «Delete Original Surfaces» (удалить исходные кривые) 

снят. 

Вводим: 

 «Refer. Coordinate Frame»: Coord 0 (базовая система координат) 

 «Axis»: Coord 0.3 (ось вращения – ось Z) 

 «Rotation Angle»: 90 (угол поворота, град) 

 «Offset Angle»: 0 (отступ угла, град) 

 «Repeat Count»: 3 (количество повторов) 

 «Surface List»: Surface 1 2 (список поверхностей) 

Apply. 

7. Задать опорные точки сетки. 

Выбираем приложение «Elements». 

Для задания неравномерного расположения опорных точек при изменении 

в одном направлении устанавливаем сочетание Create/Mesh Seed/One Way 

Bias. 

Используя опцию «L1 и L2», вводим размеры элементов в начале и в кон-

це линии (в мм): L1 = 15 и L2 = 50. 

Активизируем поле «Curve List» и последовательно указываем все обра-

зующие конуса, при необходимости нажимая Apply. 

8. Разбить поверхности на конечные элементы. 
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Для генерации сетки в том же приложении устанавливаем сочетание  

Create/Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad (четырёхугольная форма) 

 «Mesher»: IsoMesh (генератор регулярных изосеток) 

 «Topology»: Quad4 (топология – четырёхугольник с четырьмя узлами). 

Активизируем поле «Surface List» и в графическом окне с использованием 

клавиши Shift указываем все четыре поверхности сферического носка 

(Surface 1:7:2). 

В разделе «Global Edge Length» отключаем опцию автоматического вы-

числения глобальной длины стороны элемента и в поле «Value» вводим 

значение 15 (в мм). Apply. 

Снова активизируем поле «Surface List» и указываем теперь четыре по-

верхности конуса (Surface 2:8:2). Apply. 

Получаемая при этом разбивка показана на рисунке 7.2. 

 

 
Рисунок 7.2 – Конечно-элементная сетка 

 

9. Сшить конечно-элементную модель. 

Устанавливаем сочетание Equivalence/All/Tolerance Cube. 

Ничего не меняя, нажимаем Apply. При этом места сшивки модели будут 

обведены кружочками. 
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10. Построить модель двухмерного ортотропного материала для слоёв, арми-

рованных тканью. 

Запускаем приложение «Materials» и для задания свойств двухмерного ор-

тотропного материала выбираем сочетание Create/2d Orthotropic/Manual 

Input. 

В поле «Material Name» вводим имя материала, например fabric. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 2.8e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 1.9e4 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.14 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 3.1e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 3.1e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 3.1e3 (модуль сдвига 13G , МПа) 

OK. 

Нажимаем Apply. 

11. Ввести информацию по критерию разрушения. 

Для модели материала fabric снова нажимаем Input Properties. 

В выпадающих меню выбираем: 

 «Constitutive Model»: Failure (модель состояния – разрушение) 

 «Failure Limits»: Stress (ввод разрушающих напряжений) 

 «Composite Failure Theory»: Maximum (критерий максимальных напря-

жений). 

Вводим значения разрушающих напряжений: 

 «Tension Stress Limit 11» = 500 (предел прочности при растяжении 

вдоль нитей основы 1вσ + , МПа) 

 «Tension Stress Limit 22» = 320 (предел прочности при растяжении 

вдоль нитей утка 2вσ + , МПа) 

 «Compress Stress Limit 11» = 260 (модуль предела прочности при сжа-

тии вдоль нитей основы 1в| |σ − , МПа) 

 «Compress Stress Limit 22» = 180 (модуль предела прочности при сжа-

тии вдоль нитей утка 2в| |σ − , МПа) 

 «Shear Stress Limit» = 35 (предел прочности при сдвиге в плоскости 

слоя 12вσ , МПа) 
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 «Bonding Shear Stress Limit» = 1000 (предел прочности при межслоевом 

сдвиге 23вσ  и 13вσ , МПа) 

OK. 

Отметим, что последнее значение здесь задано произвольно большим. 

Нажимаем кнопку Apply. 

12. Открыть новую базу данных в MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab7.Layup, OK. 

13. Создать LM-материал. 

В выпадающих меню приложения MSC.Laminate Modeler выбираем соче-

тание Create/LM_Material/Add. 

Используем установленный по умолчанию тип материала Drape (Scissor) – 

драпированный раскроем. 

В списке «Analysis Materials» выбираем материал fabric. 

Вводим: 

«Thickness»: 0.3 (толщина, мм) 

«Maximum Strain»: 65 (максимальная деформация сдвига, град) 

«Warp/Weft Angle»: 90 (угол между нитями основы и утка, град) 

Apply. 

14. Создать LM-слои. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Используем «Type»: Drape (Scissor). 

В списке «Select LM_Material» выделяем материал Mat_1. 

Для первого LM- слоя активизируем поле «Select Area» и в графическом 

окне в качестве покрываемой им области указываем все поверхности (Sur-

face 1:8). 

С помощью кнопки Label Control панели инструментов включаем нумера-

цию точек и поверхностей. 

За начальную точку принимаем вершину сферического носка, т.е. «Start 

Point»: Point 5. 

Вводим: 

 «Application Direction»: <0. 0. -1.> (направление прикладывания) 

 «Reference Direction»: Coord 0.1 (базовое направление) 

 «Reference Angle»: 0 (базовый угол). 
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Для задания дополнительных параметров нажимаем кнопку Additional 

Controls. 

В разделе «Control Parameters» активизируем опцию Geometry (параметры, 

определяющие алгоритм глобальной выкладки). 

Выбираем: 

 «Axis Type»: Geodesic (тип осей – геодезический) 

 «Extension Type»: Geodesic (тип распространения – геодезический) 

OK. 

Apply. 

На рисунке 7.3 показаны модель драпировки и выкройка для первого LM-

слоя. Отсутствие красных участков говорит о том, что деформация сдвига 

не превышает максимально допустимого значения, равного 65°. 

 

 
Рисунок 7.3 – Изображение первого LM- слоя 

 

Для удаления с экрана результатов драпировки нажимаем кнопку    до-

полнительной панели инструментов, управляющей изображением слоёв. 

Далее определяем второй LM- слой, снова активизируем поле «Select 

Area» и указываем поверхности конуса (Surface 2:8:2). 

За начальную принимаем точку 7, т.е. «Start Point»: Point 7. 
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Вводим: 

 «Application Direction»: Normal (по нормали к поверхности) 

 «Reference Direction»: Coord 0.1 

 «Reference Angle»: 0. 

Нажимаем кнопку Additional Controls. 

Как и в предыдущем случае, для опции Geometry используем значения 

«Axis Type»: Geodesic и «Extension Type»: Geodesic. 

В разделе «Control Parameters» активизируем опцию Boundaries (парамет-

ры, определяющие границы слоя). 

Устанавливаем флаг «Define Splits» (определить разрывы). 

Для поля «Select Curves and Edges» указываем образующую конуса, про-

ходящую через точку 7 (Surface 2.2). Add. 

Снимаем флаг «Limit Fabric Size» (ограничить размер ткани). 

OK и Apply. 

Модель драпировки и выкройка для второго LM-слоя представлены на ри-

сунке 7.4. Видно, что вектор направления прикладывания здесь указывает 

на внутреннюю сторону поверхности, а не на внешнюю, на которую про-

изводится выкладка слоёв. Однако это направление можно легко поменять 

на обратное при определении LM-пакета. 

 

 
Рисунок 7.4 – Изображение второго LM- слоя 
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Аналогично создаём третий LM- слой. Он отличается от второго лишь 

тем, что разрыв здесь располагается вдоль противоположной образующей 

конуса, проходящей через точку 11 (Surface 6.2). 

При определении четвёртого LM- слоя для поля «Select Area» указываем 

половину обтекателя, а именно поверхности 1, 2, 3 и 4, лежащие по ту же 

сторону от координатной плоскости XZ , что и положительное направле-

ние оси Y  (Surface 1:4). 

Вводим: 

 «Start Point»: Point 4 

 «Application Direction»: Normal 

 «Reference Direction»: Coord 0.2 

 «Reference Angle»: 0. 

Нажимаем кнопку Additional Controls, активизируем опцию Boundaries и 

снимаем флаг «Define Splits». 

OK. 

В данном случае после нажатия Apply появится сообщение о том, что де-

формация материала превысила предельно допустимое для имитации дра-

пировки значение, равное 85°. Закрываем его, а также второе сообщение 

(о невозможности создания слоя Ply_4) кнопкой OK. 

Для устранения этой проблемы изменим базовый угол, для чего в поле 

«Reference Angle» вводим значение 45 (в градусах). 

Apply. 

При этом максимальная деформация сдвига равна 47,2° (рисунок 7.5). 

В заключение создадим подобный пятый LM- слой на противоположной 

половине обтекателя. 

Для него меняем лишь следующие значения: 

 «Select Area»: Surface 5:8 

 «Reference Angle»: -45. 

Apply. 

15. Создать LM-пакет. 

Устанавливаем сочетание Create/LM_Layup/Add. 

Нажимаем кнопку Layup Definition и из списка «Existing LM_Plys» выби-

раем слои в соответствии с таблицей 7.1. 

Отметим, что здесь направление прикладывания слоя следует поменять на 

обратное, если оно указывает на внутреннюю сторону поверхности. В на-

шем случае это необходимо сделать для LM-слоёв Ply_2 и Ply_3. 
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Рисунок 7.5 – Изображение четвёртого LM- слоя 

 

Таблица 7.1 – Определение LM- пакета 

№ LM_Ply  [Reference Angle] [Application Direction] 
1 Ply_1 0 Original 
2 Ply_2 0 Reversed 
3 Ply_3 0 Reversed 
4 Ply_4 45 Original 
\5 Ply_5 -45 Original 
/6 Ply_5 -45 Original 
7 Ply_4 45 Original 
8 Ply_3 0 Reversed 
9 Ply_2 0 Reversed 
10 Ply_1 0 Original 

 

Переместим нижний ползунок до конца вправо. В соответствующих ячей-

ках столбца «Application Direction» щелчком левой кнопки мыши меняем 

исходное (Original) направление на обратное (Reversed). 

Нажимаем последовательно  OK и  Apply. 

При этом появится сообщение о том, что расчётная модель требует созда-

ния 238 наборов свойств элементов. Нажимаем Yes. 

Приложение MSC.Laminate Modeler можно закрыть. Нажимаем Close и 

Cancel. 

16. Проверить созданные свойства элементов и слоистые материалы. 



 67

Для просмотра свойств элементов запускаем приложение «Properties» и 

устанавливаем Action: Show. 

В списке существующих свойств «Existing Properties» выбираем строку 

Thickness (толщина). Apply. 

Распределение толщины по модели обтекателя показано на рисунке 7.6. 

 

 
Рисунок 7.6 – Изменение толщины обтекателя (в мм) 

 

Для просмотра сгенерированных модулем MSC.Laminate Modeler слои-

стых материалов выбираем приложение «Materials» и устанавливаем соче-

тание Show/Composite/Laminate. 

В списке «Laminated Composites» выбираем конкретный слоистый мате-

риал Clab7_n (где n = 1, 2,..., 238 – порядковый номер). 

При этом в дополнительном окне будет показана выкладка пакета. Здесь 

следует обратить внимание на толщины и ориентацию слоёв. 

Для вывода на экран матриц жесткостных характеристик пакета нажимаем 

кнопку Show Laminate Properties и выбираем опцию «A, B, and D 

Matrices». Cancel. 

17. Построить цилиндрическую систему координат. 
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В дальнейшем для описания изменения нагрузки нам потребуется цилин-

дрическая система координат. 

Выбираем приложение «Geometry» и для определения системы координат 

по трём точкам устанавливаем сочетание Create/Coord/3Point. 

Здесь меняем только тип системы координат, т.е. «Type»: Cylindrical (ци-

линдрическая), Apply. 

При этом будет построена цилиндрическая система координат Coord 1, 

начало которой совпадает с началом глобальной декартовой системы ко-

ординат (изображается белым крестом). 

18. Построить пространственное поле, описывающее изменение давления на 
коническом участке обтекателя. 

Запускаем приложение «Fields» и для задания пространственного поля с 

помощью функций языка PCL устанавливаем сочетание Create/Spatial/PCL 

Function. 

Вводим: 

 «Field Name»: p_cone (имя пространственного поля) 

 «Field Type»: Scalar (тип поля – скалярное) 

 «Coordinate System Type»: Real (тип системы координат – физическая 

действительная) 

 «Coordinate System»: Coord 1 (система координат – номер 1, т.е. в на-

шем случае цилиндрическая) 

 «Scalar Function»: 0.015*COSR(‘T/2)+0.045*’Z/1000 (скалярная функ-

ция) 

Apply. 

Напомним, что в PCL-выражении перед переменными должен стоять апо-

строф. Их можно выбирать из расположенного ниже списка. 

Для проверки правильности задания поля отобразим его в виде семейства 

двухмерных графиков (действие Show). 

Используя в качестве независимой угловую переменную T, нажимаем 

Specify Range (задать диапазон) и в соответствующие поля вводим: 

 Minimum Maximum No. of Points 
T 0 6.28 20 
Z 0 1000 10 

OK. 

После нажатия Apply в отдельном окне появляются графики, а рядом – 

таблица значений. Закрываем её кнопкой Cancel. 
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Для закрытия окна с графиками следует воспользоваться кнопкой Unpost 

Current  XYWindow. 

19. Задать граничные условия. 
Запускаем приложение «Loads/BCs» и для задания перемещений устанав-

ливаем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя нового набора, например clamped. 

Нажимаем кнопку Input Data и для моделирования жёсткого защемления 

фиксируем как поступательные перемещения, так и углы поворота, т.е. в 

полях «Translations» и «Rotations» вводим  <0,0,0>, OK. 

Нажимаем Select Application Region. Для выбора геометрических объектов 

используем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (кривая или кромка) и с помощью клавиши 

Shift указываем все четыре кромки нижнего основания обтекателя (Surface 

2.3 4.3 6.3 8.3). 

Последовательно нажимаем кнопки Add, OK и Apply. 

20. Приложить нагрузку. 
Для задания давления в том же приложении выбираем сочетание Create/ 

Pressure/Element Uniform. 

Сначала задаём нагрузку на сферическом участке. 

В поле «New Set Name» вводим имя нового набора, например load_sphere. 

В качестве типа целевых элементов выбираем поверхностные, т.е. «Target 

Element Type»: 2D. 

Нажимаем кнопку Input Data и в поле «Top Surf Pressure» (давление на 

верхней поверхности) вводим значение 0.06 (в МПа). OK. 

Далее нажимаем кнопку Select Application Region. Используем опцию «Se-

lect»: Geometry. 

Активизируем поле «Select Surfaces or Edges», в пиктографическом меню 

выбора нажимаем кнопку      (поверхность или грань) и при помощи кла-

виши Shift указываем все четыре поверхности сферического носка (Sur-

face 1:7:2). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

Затем задаём нагрузку на коническом участке. 

В поле «New Set Name» вводим другое имя, например load_cone. 
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Нажимаем кнопку Input Data, активизируем область ввода «Top Surf Pres-

sure» и ниже в списке пространственных полей «Spatial Fields» указываем 

строку p_cone. OK. 

Далее нажимаем кнопку Select Application Region и указываем четыре по-

верхности конического участка (Surface 2:8:2). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

21. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Для оценки прочности композитной конструкции здесь следует отклю-

чить опцию распределения результатов по глобальным слоям. 

Нажимаем кнопку Translation Parameters и снимаем флаг «Write Global 

Ply IDs», OK. 

Для изменения типа решения нажимаем кнопку Solution Type и выбираем 

Buckling (анализ начальной устойчивости), OK. 

Отметим, что при решении задачи начальной устойчивости напряжения 

по умолчанию не выводятся. Модифицируем расчётный случай. С этой 

целью нажимаем кнопку Subcases. 

В списке доступных расчётных случаев «Available Subcases» указываем 

Default. Данное имя должно появиться в поле «Subcase Name». 

Далее нажимаем кнопку Output Request (запросы по выводу). 

В верхнем списке «Select Result Type» указываем строку Element Stresses 

(напряжения в элементах), OK. 

Затем последовательно нажимаем Apply и Cancel. 

И наконец, собственно для запуска задачи на счёт нажимаем кнопку Apply 

основной диалоговой панели приложения. 

22. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

clab7.xdb, OK. 

В заключение нажимаем Apply. 

23. Оценить устойчивость обтекателя. 
Запускаем приложения «Results». Используем сочетание Create/Quick Plot. 
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Следует отметить, что решение задачи начальной устойчивости выполня-

ется в два этапа. Сначала проводится линейный статический анализ, а за-

тем решается проблема собственных значений. Поэтому в списке «Select 

Result Cases» здесь будут представлены два случая результатов De-

fault, A1:Static Subcase и Default, A1:Mode 1, соответствующие двум ука-

занным выше этапам. 

На втором этапе определяется наименьшее собственное значение, показы-

вающее во сколько раз критическая нагрузка больше приложенной. Оно 

является по сути дела коэффициентом запаса по устойчивости. 

Собственное значение приводится после названия второго случая резуль-

татов: 

Factor = 1.2474. 

Поскольку коэффициент запаса по устойчивости больше единицы, при за-

данной нагрузке рассматриваемая конструкция устойчивость не теряет. 

24. Создать новый случай результатов, содержащий рассчитанные значения 

критерия разрушения. 

В полосе меню выбираем команду Tools>Laminate Modeler>Laminate. 

При этом справа появляется диалоговая панель, где устанавливаем соче-

тание Create/Results/Failure Calc. 

В списке «Select Results Cases» указываем случай результатов De-

fault, A1:Static Subcase, а в списке «Select Layered Result» – Stress Tensor. 

Далее активизируем поле «Select Area» и в графическом окне зоной выбо-

ра в виде прямоугольника охватываем всю модель. 

В выпадающем меню «Criterion» в качестве критерия разрушения выбира-

ем Maximum. 

В поле «Name» вводим имя набора результатов, например my. 

Нажимаем Apply и Close. 

25. Оценить прочность обтекателя. 
Если в диалоговой панели приложения «Results» не появился третий слу-

чай результатов, то следует данное приложение закрыть и снова открыть. 

В списке «Select Result Cases» выбираем последний случай результатов 

Default, a1:Static Subcase. 

Ниже в списке «Select Fringe Result» для определения наименьших по сло-

ям значений коэффициента запаса безопасности указываем строку Margins 

of Safety (Worst)*, Maximum Stress (my). 

Apply. 
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Получаемое здесь изображение показано на рисунке 7.7. Видно, что ми-

нимальное значение коэффициента запаса безопасности по критерию мак-

симальных напряжений minMoS  составляет 30,8. 

 

 
Рисунок 7.7 – Наименьшие по слоям значения коэффициента  
запаса безопасности по критерию максимальных напряжений 

 

Найдём минимальное значение коэффициента запаса прочности: 

min min 1 31,8SR MoS= + = . 

Если же выбрать строку Failure Indices (Worst)*, Maximum Stress (my), то 

можно увидеть, что максимальное значение критерия разрушения maxFI  

составляет 3,14·10-2. Учитывая, что критерий максимальных напряжений 

является линейным, по данному значению можно также рассчитать коэф-

фициент запаса прочности 

min max1 31,8SR FI= = . 

Получается тот же результат. 

Таким образом, для рассматриваемой композитной конструкции коэффи-

циент запаса прочности значительно превышает коэффициент запаса по 
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устойчивости, т.е. более опасным видом исчерпания несущей способности 

для неё является потеря устойчивости, а не разрушение материала. 

26. Повторно запустить приложение MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

Попадаем в окно инициализации и открываем базу данных с именем 

Clab7.Layup, нажав кнопку Open Layup File, OK. 

27. Сформировать книгу слоёв. 
Здесь полезно предварительно убрать с экрана изображение конечно-

элементных объектов. С этой целью выбираем в полосе меню команду 

Display>Plot/Erase и в подразделе «FEM» нажимаем кнопку Erase (сте-

реть). OK. 

Устанавливаем сочетание Create/Ply Book/LM_Layup. 

Для выбора всех глобальных слоёв нажимаем кнопку Select All. 

Apply. 

Отметим, что книга слоёв записывается в файл Clab4.html. 

При этом если установлены флаги «Ply Data» и «Image Creation», то на эк-

ране будет заново воспроизводиться процесс создания выбранных слоёв, и 

их изображения будут помещаться в отдельные графические файлы, а 

также в книгу слоёв. 

Кроме того, с помощью кнопки Export Options здесь можно включить оп-

ции создания 3D-моделей драпированных слоёв и их выкроек в форматах 

IGES и DFX. 

Чтобы закрыть приложение MSC.Laminate Modeler, нажимаем Close и 

Cancel. 

28. Выйти из программы: File>Quit. 
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ЛАБОРАТОРНАЯ  РАБОТА  № 8 

«Анализ температурных деформаций, возникающих в  
процессе изготовления обтекателя реактивного двигателя» 

 

Исходные данные: обтекатель реактивного двигателя является 24-

слойной оболочкой со структурой укладки [0°/45°/90°/-45°]6. Он изготавли-

вается путём выкладки однонаправленных слоёв углепластика на поверх-

ность формы, представляющую собой половину поверхности вращения (ри-

сунок 8.1). Свойства углепластика: 4
1 18,1 10E = ⋅ МПа; 3

2 10,3 10E = ⋅ МПа; 

12 0,28µ = ; 3
12 6,1 10G = ⋅ МПа; 3

23 4 10G = ⋅ МПа; 3
13 6,1 10G = ⋅ МПа; темпера-

турные коэффициенты линейного расширения соответственно вдоль и попе-

рёк волокон 8
1 2 10α −= ⋅ 1/°С и 5

2 2,25 10α −= ⋅ 1/°С. Исходная толщина слоя 

равна 0,25 мм, а максимально допустимая деформация сдвига в процессе 

драпировки – 60°. Температура отверждения полимерного связующего со-

ставляет 180°. 

Цель: исследовать температурные деформации, возникающие при ох-

лаждении композиции после отверждения связующего. 

 

 
Рисунок 8.1 – Геометрия поверхности формы 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить MSC.Patran и открыть новую базу данных: File>New. 

В поле «File name» указываем имя файла базы данных Clab8.db, OK. 

2. Задать начальные установки. 
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В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» и в поле «Model Dimension» вводим значе-

ние 3000 (в мм), OK. 

3. Построить точки согласно следующей таблице: 

 

Номер  
точки 

X, 
мм 

Y, 
мм 

Z, 
мм 

Ввод 

1 0 1000 0 [0 1000 0] 
2 1000 1200 0 [1000 1200 0] 
3 3000 1000 0 [3000 1000 0] 

 

Выбираем приложение «Geometry» и для ввода точек по их координатам 

устанавливаем сочетание Create/Point/XYZ. 

В поле «Point Coordinate List» последовательно вводим координаты точек 

в квадратных скобках, как показано в последнем столбце таблицы. Каж-

дый ввод завершаем нажатием кнопки Apply. 

4. Построить сплайн, проходящий через три заданные точки. 

Устанавливаем сочетание Create/Curve/Spline. 

В меню «Option» выбираем опцию B-Spline (B-сплайн). 

При помощи ползунка задаём порядок сплайна (Order) равным 3. 

Устанавливаем флаг «Interpolation» (интерполяция). 

Используем опцию «Chord Length» (длина хорды). 

Для поля «Point List» указываем все три точки (Point 1:3). 

Apply. 

5. Построить поверхность вращением сплайна вокруг прямолинейной оси. 

Устанавливаем сочетание Create/Surface/Revolve. 

В соответствующие поля вводим: 

 «Refer. Coordinate Frame»: Coord 0 (базовая система координат) 

 «Axis»: Coord 0.1 (ось вращения – ось X) 

 «Total Angle»: 180 (полный угол, град) 

 «Offset Angle»: 0 (отступ угла, град) 

 «Curve List»: Curve 1 (список кривых) 

Apply. 

С помощью кнопки Iso 3 View панели инструментов меняем проекцию. 

6. Разбить поверхность на конечные элементы. 

Запускаем приложение «Elements» и устанавливаем сочетание Create/ 

Mesh/Surface. 
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Выбираем: 

 «Elem Shape»: Quad (четырёхугольная форма) 

 «Mesher»: IsoMesh (генератор регулярных изосеток) 

 «Topology»: Quad4 (топология – четырёхугольник с четырьмя узлами). 

Активизируем поле «Surface List» и в графическом окне указываем един-

ственную поверхность (Surface 1). 

В разделе «Global Edge Length» отключаем опцию автоматического вы-

числения глобальной длины стороны элемента и в поле «Value» вводим 

значение 150 (в мм). Apply. 

Получаемая при этом разбивка показана на рисунке 8.2. 

 

 
Рисунок 8.2 – Конечно-элементная модель 

 

7. Построить модель двухмерного ортотропного материала для однонаправ-
ленных слоёв углепластика. 

Запускаем приложение «Materials» и устанавливаем сочетание Create/ 

2d Orthotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например layer. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 18.1e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 10.3e3 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.28 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 6.1e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 4e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 6.1e3 (модуль сдвига 13G , МПа) 

 «Thermal Expan. Coeff 11» = 2e-8 (температурный коэффициент линей-

ного расширения 1α , 1/°С) 
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 «Thermal Expan. Coeff 22» = 2.25e-5 (температурный коэффициент ли-

нейного расширения 2α , 1/°С) 

 «Reference Temperature» = 180 (базовая температура, °С) 

OK. 

Отметим, что в качестве базовой температуры здесь задана температура 

отверждения полимерного связующего. 

Нажимаем Apply. 

8. Открыть новую базу данных в MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab8.Layup, OK. 

9. Создать LM-материал. 

В выпадающих меню приложения MSC.Laminate Modeler устанавливаем 

сочетание Create/LM_Material/Add. 

Поскольку материал слоя является однонаправленным, выбираем тип 

Drape (Slide) – драпированный скольжением. 

В списке «Analysis Materials» указываем материал layer и в поле «Thick-

ness» вводим значение толщины (в мм): 0.25. Задаваемое по умолчанию в 

поле «Maximum Strain (degrees)» значение максимально допустимой де-

формации сдвига составляет 60°. Оставляем его без изменения. Apply. 

10. Создать LM-слои. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Выбираем «Type»: Drape (Slide). 

В списке «Select LM_Material» выделяем материал Mat_1. 

Для первого LM-слоя в соответствующие поля вводим: 

 «Select Area»: Surface 1  

 «Start Point»: [1250 0 1250]  

 «Application Direction»: <0. 0. -1.> 

 «Reference Direction»: Coord 0.1  

 «Reference Angle»: 0. 

Для задания дополнительных параметров нажимаем кнопку Additional 

Controls и в разделе «Control Parameters» активизируем опцию Geometry. 

Выбираем «Extension Type»: Geodesic. OK. 

Apply. 
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Создаём ещё три аналогичных LM-слоя, но с другими базовыми углами: 

45°, 90° и -45°. 

Отображаемые в графическом окне модель драпировки и выкройка для 

второго LM-слоя показаны на рисунке 8.3. 

 

 
Рисунок 8.3 – Изображение второго LM- слоя 

 

11. Создать LM-пакет. 

Устанавливаем сочетание Create/LM_Layup/Add. 

Нажимаем кнопку Layup Definition и из списка «Existing LM_Plys» выби-

раем шесть раз последовательно слои Ply_1, Ply_2, Ply_3 и Ply_4, чтобы 

получился 24-слойный пакет. 

Нажимаем OK и  Apply. 

При этом появится сообщение о том, что расчётная модель требует созда-

ния 30 наборов свойств элементов. Нажимаем Yes. 

Приложение MSC.Laminate Modeler можно закрыть. Нажимаем Close и 

Cancel. 

12. Задать граничные условия. 
Закрепим конструкцию так, чтобы устранить возможность её перемеще-

ния как жёсткого целого. 

Запускаем приложение «Loads/BCs» и для задания перемещений выбира-

ем сочетание Create/Displacement/Nodal. 

С помощью кнопки Front view панели инструментов устанавливаем вид 

спереди, т.е. на плоскость XY. 
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В поле «New Set Name» вводим имя вновь создаваемого набора, например 

xyz. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,0,0>, OK. 

Нажимаем Select Application Region. Для выбора геометрических объектов 

устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (точка или вершина) и указываем нижний ле-

вый угол модели. 

Последовательно нажимаем кнопки Add, OK и Apply. 

Далее в поле «New Set Name» вводим другое имя, например xz. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,,0>, OK. 

Нажимаем Select Application Region и для поля «Select Geometry Entities» 

указываем верхний левый угол. 

Последовательно нажимаем кнопки Add, OK и Apply. 

Затем в поле «New Set Name» вводим ещё одно имя, например z. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <,,0>, OK. 

Нажимаем Select Application Region и для поля «Select Geometry Entities» 

указываем нижний правый угол. 

Последовательно нажимаем кнопки Add, OK и Apply. 

13. Приложить нагрузку. 
Для задания температурной нагрузки в том же приложении выбираем со-

четание Create/Temperature/Nodal. 

В поле «New Set Name» вводим имя нового набора, например load. 

Нажимаем кнопку Input Data и в поле «Temperature» вводим значение 

комнатной температуры (в °С): 20. OK. 

Далее нажимаем кнопку Select Application Region. Используем опцию «Se-

lect»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (поверхность или грань) и указываем по-

верхность 1. 

Последовательно нажимаем кнопки Add, OK и  Apply. 

14. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Ничего не меняя, нажимаем кнопку Apply. 
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15. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

clab8.xdb, OK. 

В заключение нажимаем Apply. 

16. Отобразить поле температурных перемещений. 

Выбираем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 

В списке «Select Fringe Result» в качестве величины для многоцветного 

представления её поля указываем Displacements, Translational (поступа-

тельные перемещения). 

Ниже в меню «Quantity» выбираем Magnitude. 

Далее в списке «Select Deformation Result» в качестве результата для изо-

бражения деформированного состояния модели указываем строку Dis-

placement, Translational. 

Нажимаем  Apply. 

На рисунке 8.4 можно увидеть, что происходит с рассматриваемой конст-

рукцией при снятии её с формы после охлаждения от температуры отвер-

ждения связующего до комнатной температуры. 

 

 
Рисунок 8.4 – Поле перемещений (мм) 

 

Вследствие ортотропии физико-механических свойств материала здесь 

происходит достаточно сильное деформирование, и конфигурация изго-
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тавливаемой конструкции будет заметно отличаться от геометрии поверх-

ности формы. Этот факт следует учитывать при изготовлении технологи-

ческой оснастки. 

17. Выйти из программы: File>Quit. 
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ЛАБОРАТОРНАЯ  РАБОТА  № 9 

«Моделирование Т-образной конструкции» 

 

Исходные данные: элемент обтекателя имеет форму поверхности, обра-

зованной вращением Т-образной кривой (рисунок 9.1) вокруг оси X  на угол 

30°. Он выкладывается из однонаправленных слоёв углепластика, покры-

вающих разные области. Свойства углепластика: 4
1 18,1 10E = ⋅ МПа; 2E =  

310,3 10= ⋅ МПа; 12 0,28µ = ; 3
12 6,1 10G = ⋅ МПа; 3

23 4 10G = ⋅ МПа; 13G =  
36,1 10= ⋅ МПа. Исходная толщина слоя составляет 0,25 мм. На внутреннюю 

поверхность панели элемента обтекателя действует давление 0,1p = МПа. 

При этом нижняя кромка стенки шарнирно опёрта, а верхняя кромка, примы-

кающая к панели, закреплена от осевых перемещений. 

Цель: исследовать напряжённо-деформированное состояние элемента 

обтекателя. 

 

 
Рисунок 9.1 – Т-образная кривая 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить MSC.Patran и открыть новую базу данных: File>New. 

В поле «File name» указываем имя файла базы данных Clab9.db, OK. 

2. Задать начальные установки. 

Y  

300 

20
0 

X  150 

10
0 

10
0 
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В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» и в поле «Model Dimension» вводим значе-

ние 300 (в мм), OK. 

3. Построить образующую панели. 

Выбираем приложение «Geometry» и устанавливаем сочетание Create/ 

Curve/XYZ. 

В соответствующие поля вводим: 

 «Vector Coordinate List»: <300 -100 0> (координаты вектора, мм) 

 «Origin Coordinates List»: [0 200 0] (координаты начала, мм) 

Apply. 

4. Разбить линию на несколько частей. 

С помощью кнопки Label Control панели инструментов включаем нумера-

цию геометрических объектов. 

Устанавливаем сочетание Edit/Curve/Break. 

В меню «Option» выбираем опцию Parametric (параметрическое задание 

точки разбиения). 

Для поля «u Parametric Value» (значение параметрической координаты) 

используем значение 0.5, задаваемое по умолчанию. 

Для удаления исходных кривых устанавливаем флаг «Delete Original 

Curves». 

Для поля «Curve List» указываем Curve 1. 

Если требуется, нажимаем Apply и кнопкой Yes подтверждаем удаление 

кривой 1. 

Аналогично делим пополам последовательно кривые 2, 5, 3 и 8. 

5. Построить образующую стенки. 

Опять устанавливаем сочетание Create/Curve/XYZ. 

Вводим: 

 «Vector Coordinate List»: <0 -50 0>  

 «Origin Coordinates List»: Point 3 

Apply. 

6. Построить поверхность вращением Т-образной кривой вокруг прямоли-

нейной оси. 

Устанавливаем сочетание Create/Surface/Revolve. 

В соответствующие поля вводим: 

 «Refer. Coordinate Frame»: Coord 0 (базовая система координат) 

 «Axis»: Coord 0.1 (ось вращения – ось X) 



 84

 «Total Angle»: 30 (полный угол, град) 

 «Offset Angle»: 0 (отступ угла, град) 

 «Curve List»: Curve 4 6 7 9:12 (список кривых) 

Apply. 

С помощью кнопки Iso 3 View панели инструментов меняем проекцию. 

Получаемые при этом поверхности показаны на рисунке 9.2. 

 

 
Рисунок 9.2 – Нумерация поверхностей 

 

7. Разбить поверхности на конечные элементы. 

Запускаем приложение «Elements» и устанавливаем сочетание Create/ 

Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad 

 «Mesher»: IsoMesh 

 «Topology»: Quad4. 

Активизируем поле «Surface List» и в графическом окне указываем сразу 

все поверхность (Surface 1:7). 

Используем опцию автоматического вычисления глобальной длины сто-

роны элемента «Automatic Calculation». Apply. 

8. Сшить конечно-элементную модель. 

Устанавливаем сочетание Equivalence/All/Tolerance Cube. 

Ничего не меняя, нажимаем Apply. При этом места сшивки модели будут 

обведены кружочками. 

9. Построить модель двухмерного ортотропного материала для однонаправ-
ленных слоёв углепластика. 
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Запускаем приложение «Materials» и устанавливаем сочетание Create/ 

2d Orthotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например layer. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 18.1e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 10.3e3 (модуль упругости 2E , МПа) 

 «Poisson Ratio 12» = 0.28 (коэффициент Пуассона 12µ ) 

 «Shear Modulus 12» = 6.1e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 4e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 13» = 6.1e3 (модуль сдвига 13G , МПа) 

OK. 

Нажимаем Apply. 

10. Открыть новую базу данных в MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab9.Layup, OK. 

11. Создать LM-материал. 

В выпадающих меню приложения MSC.Laminate Modeler выбираем соче-

тание Create/LM_Material/Add. 

Поскольку материал слоя является однонаправленным, выбираем тип 

Drape (Slide) – драпированный скольжением. 

В списке «Analysis Materials» указываем материал layer и в поле «Thick-

ness» вводим значение толщины (в мм): 0.25. 

Apply. 

12. Создать LM-слои. 

С помощью кнопки Label Control панели инструментов отключаем нуме-

рацию геометрических объектов и включаем нумерацию узлов. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Выбираем «Type»: Drape (Slide). 

В списке «Select LM_Material» выделяем материал Mat_1. 

Для первого LM- слоя активизируем поле «Select Area» и в графическом 

окне сначала указываем поверхности 1, 2 и 3 (Surface 1:3). 

За начальную точку примем узел, расположенный в середине линии со-

пряжения стенки с панелью, т.е. «Start Point»: Node 75. 
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В качестве направления прикладывания в поле «Application Direction» 

вручную (Manual) вводим вектор <1. 1. 0.>. 

Базовое направление зададим вдоль средней образующей панели, т.е. от 

узла 75 к узлу 108. Для этого активизируем поле «Reference Direction», в 

пиктографическом меню выбора последовательно нажимаем кнопки  

      (база и концевые точки) и       (узел) и указываем сначала Node 75, а за-

тем Node 108. Должна появиться запись: Construct 2PointVector(Evaluate 

Geometry(Node 75))(Evaluate Geometry(Node 108)). 

Базовый угол принимаем равным нулю, т.е. «Reference Angle»: 0. 

Для добавления к области, покрываемой слоем, поверхности 7, которая 

должна драпироваться во вторую очередь, нажимаем кнопку Additional 

Controls и в разделе «Control Parameters» активизируем опцию Order of 

Draping (порядок драпировки). 

В таблице «Area» выделяем вторую строку, активизируем поле «Select 

Area» и в графическом окне указываем поверхность 7 (Surface 7), OK. 

Apply. 

Аналогично создаём второй LM- слой. Он отличается от первого лишь ба-

зовым углом, т.е. «Reference Angle»: 45. 

Отображаемые в графическом окне модель драпировки и выкройка для 

второго LM-слоя показаны на рисунке 9.3. 

 

 
Рисунок 9.3 – Изображение второго LM- слоя 
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Для всех последующих слоёв начальную точку и базовое направление ос-

тавляем прежними. 

При определении третьего LM- слоя сначала для поля «Select Area» ука-

зываем поверхности 4, 5 и 6 (Surface 4:6). 

Вводим: 

 «Application Direction»: <-1. 1. 0> 

 «Reference Angle»: 0. 

Для добавления к области покрытия поверхности 7 нажимаем кнопку Ad-

ditional Controls и в разделе «Control Parameters» активизируем опцию Or-

der of Draping. 

Если во второй строке таблицы «Area» отсутствует запись Surface 7, то её 

следует выделить, активизировать поле «Select Area» и в графическом ок-

не указать поверхность 7, OK. 

Apply. 

Четвёртый LM- слой отличается от предыдущего лишь базовым углом, 

который составляет 45°. 

Для пятого LM- слоя вводим: 

 «Select Area»: Surface 3 5 

 «Application Direction»: <0. -1. 0> 

 «Reference Angle»: 0. 

Поверхность 7 здесь следует исключить из области, покрываемой слоем. 

Для этого нажимаем кнопку Additional Controls и в разделе «Control Pa-

rameters» активизируем опцию Order of Draping. 

Выделяем вторую строку таблицы «Area» и в поле «Select Area» удаляем 

запись Surface 7, OK. 

Apply. 

Для шестого LM- слоя базовый угол равен -45°. 

Область, покрываемая седьмым и восьмым LM- слоями, определяется 

поверхностями 2, 3, 5 и 6, а их базовые углы соответственно равны 0° и 

45°. 

При построении девятого и десятого LM- слоёв следует выбрать область 

Surface 1:6 и задать углы 0° и -45°. 

13. Создать LM-пакет. 

Устанавливаем сочетание Create/LM_Layup/Add. 

Нажимаем кнопку Layup Definition и из списка «Existing LM_Plys» выби-

раем LM-слои согласно следующей таблице: 
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Номера глобальных слоёв Номера LM-слоёв 
1...8 1/2/1/2/1/2/1/2 
9...16 3/4/3/4/3/4/3/4 
17...24 5/6/5/6/5/6/5/6 
25...32 7/8/7/8/7/8/7/8 
33...40 9/10/9/10/9/10/9/10 

 

Последовательно нажимаем OK и Apply. 

При этом появится сообщение о том, что расчётная модель требует созда-

ния 14 наборов свойств элементов. Нажимаем Yes. 

Приложение MSC.Laminate Modeler можно закрыть. Нажимаем Close и 

Cancel. 

14. Проверить созданные свойства элементов и слоистые материалы. 

Для просмотра свойств элементов запускаем приложение «Properties» и 

устанавливаем Action: Show. 

В списке существующих свойств «Existing Properties» выбираем строку 

Thickness (толщина). Apply. 

Распределение толщины по модели элемента обтекателя показано на ри-

сунке 9.4. 

 

 
Рисунок 9.4 – Изменение толщины элемента обтекателя (в мм) 

 

Для просмотра сгенерированных модулем MSC.Laminate Modeler слои-

стых материалов выбираем приложение «Materials» и устанавливаем соче-

тание Show/Composite/Laminate. 

В списке «Laminated Composites» выбираем конкретный слоистый мате-

риал Clab9_n (где n = 1, 2,..., 14 – порядковый номер). 
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При этом в дополнительном окне будет показана выкладка пакета.  

15. Задать граничные условия. 
Запускаем приложение «Loads/BCs» и для задания перемещений выбира-

ем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя вновь создаваемого набора, например 

hinge. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,0,0>, OK. 

Нажимаем Select Application Region. Для выбора геометрических объектов 

устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку       (кривая или кромка) и указываем нижнюю 

кромку стенки (Surface 7.3). 

Последовательно нажимаем кнопки Add, OK и Apply. 

Далее в поле «New Set Name» вводим другое имя, например x. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,,>, OK. 

Нажимаем Select Application Region и для поля «Select Geometry Entities» 

указываем верхнюю кромку стенки (Surface 3.3 или Surface 7.1). 

Последовательно нажимаем кнопки Add, OK и Apply. 

16. Приложить нагрузку. 
Для задания давления в том же приложении выбираем сочетание Create/ 

Pressure/Element Uniform. 

В поле «New Set Name» вводим имя нового набора, например load. 

В качестве типа целевых элементов выбираем поверхностные, т.е. «Target 

Element Type»: 2D. 

Нажимаем кнопку Input Data и в поле «Top Surf Pressure» (давление на 

верхней поверхности) вводим значение 0.1 (в МПа). OK. 

Далее нажимаем кнопку Select Application Region. Используем опцию «Se-

lect»: Geometry. 

Активизируем поле «Select Surfaces or Edges», в пиктографическом меню 

выбора нажимаем кнопку      (поверхность или грань) и при помощи кла-

виши Shift указываем все поверхности кроме седьмой, моделирующей 

стенку (Surface 1:6). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

17. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 
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Ничего не меняя, нажимаем кнопку Apply. 

18. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

clab9.xdb, OK. 

В заключение нажимаем Apply. 

19. Изобразить поля напряжений в глобальных слоях. 

Запускаем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 

Для изображения поля напряжений в списке «Select Fringe Result» указы-

ваем строку Stress Tensor. 

Нажимаем расположенную ниже кнопку Position и выбираем конкретный 

глобальный слой Layer n (где n – номер слоя). Close. 

Выбираем «Quantity»: X Component. Apply. 

По умолчанию здесь напряжения выводятся в системе координат слоя, где 

ось X  направляется вдоль волокон однонаправленного материала (или 

нитей основы материала, армированного тканью). 

В качестве примера на рисунке 9.5 показано распределение напряжений 

xxσ  в глобальном слое №33 (1033). 

 

 
Рисунок 9.5 – Поле напряжений вдоль волокон (МПа)  

в глобальном слое №33 
 

20. Выйти из программы: File>Quit. 
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ЛАБОРАТОРНАЯ  РАБОТА  № 10 

«Моделирование массивной композитной конструкции» 

 

Исходные данные: трёхслойный упор изготавливается путём выкладки 

слоёв обшивок и сотового заполнителя на поверхность формы, представ-

ляющую собой часть поверхности вращения с центральным углом 40° (рису-

нок 10.1). Упругие свойства материала обшивок: 4
1 6,5 10E = ⋅ МПа; 2E =  

44,2 10= ⋅ МПа; 3
3 8 10E = ⋅ МПа; 12 0,15µ = ; 23 0,3µ = ; 31 0,037µ = ; 12G =  

34 10= ⋅ МПа; 3
23 4 10G = ⋅ МПа; 3

31 4 10G = ⋅ МПа. Свойства материала заполни-

теля: 1 100E = МПа; 2 100E = МПа; 3
3 3 10E = ⋅ МПа; 12 0,1µ = ; 23 0,01µ = ; 

31 0,3µ = ; 12 60G = МПа; 23 300G = МПа; 31 300G = МПа. Исходная толщина 

обшивок равна 2 мм, а заполнителя – 5 мм. На внутреннюю цилиндрическую 

поверхность упора действует давление 10p = МПа. При этом конструкция 

жёстко защемлена по нижнему основанию. 

Цель: построить объёмную модель упора; исследовать его напряжённо-

деформированное состояние. 

 

 
Рисунок 10.1 – Геометрия сечения упора 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить MSC.Patran и открыть новую базу данных: File>New. 
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В поле «File name» указываем имя файла базы данных Clab10.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» и в поле «Model Dimension» вводим значе-

ние 100 (в мм), OK. 

3. Построить дугу окружности. 

Выбираем приложение «Geometry» и устанавливаем сочетание Create/ 

Curve/2D ArcAngles. 

В соответствующие поля вводим: 

 «Radius»: 100 (радиус, мм) 

 «Start Angle»: 0 (начальный угол, мм) 

 «End Angle»: 90 (конечный угол, мм) 

 «Construction Plane List»: Coord 0.3 (плоскость построения) 

 «Center Point List»: [0 0 0] (координаты центральной точки, мм) 

Apply. 

4. Построить прямую. 

Устанавливаем сочетание Create/ Curve/XYZ. 

В соответствующие поля вводим: 

 «Vector Coordinate List»: <0 20 0> (координаты вектора, мм) 

 «Origin Coordinates List»: [30 90 0] (координаты начала, мм) 

Apply. 

5. Построить дугу скругления. 
Устанавливаем сочетание Create/Curve/Fillet. 

В поле «Fillet Radius» вводим радиус скругления (в мм): 15. 

Опция «Trim Original Curves» (подрезать исходные кривые) должна быть 

включена. 

Для поля «Curve/Point 1 List» без использования клавиши Shift указываем 

кривую 1 и её концевую точку со стороны оставляемой части (т.е. точ-

ку 1). 

Аналогично для поля «Curve/Point 2 List» указываем кривую 2 и точку 4. 

Если требуется, нажимаем Apply. 

6. Построить поверхность вращением кривых вокруг прямолинейной оси. 

Устанавливаем сочетание Create/Surface/Revolve. 

В соответствующие поля вводим: 

 «Refer. Coordinate Frame»: Coord 0 (базовая система координат) 

 «Axis»: Coord 0.2 (ось вращения – ось Y) 
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 «Total Angle»: 40 (полный угол, град) 

 «Offset Angle»: -20 (отступ угла, град) 

 «Curve List»: Curve 1:3 (список кривых) 

Apply. 

С помощью кнопки Iso 3 View панели инструментов меняем проекцию. 

7. Задать опорные точки сетки. 

Выбираем приложение «Elements». 

Для задания равномерного расположения опорных точек устанавливаем 

сочетание Create/Mesh Seed/Uniform. 

Используя опцию «Number of Elements», вводим: Number = 4. 

Активизируем поле «Curve List» и указываем сначала нижнюю кромку 

поверхности 1 (т.е. Surface 1.1), а затем боковую кромку поверхности 3 

(т.е. Surface 3.4), при необходимости нажимая Apply. 

Далее вводим другое число элементов: Number = 1. 

Для поля «Curve List» указываем боковую кромку поверхности 2 (т.е. Sur-

face 2.4). Apply. 

Для задания неравномерного расположения опорных точек при изменении 

в одном направлении выбираем сочетание Create/Mesh Seed/One Way Bias. 

Используя опцию «Num Elems and L2/L1», вводим следующие значения: 

Number = 15 и L2/L1 = -4. 

Для поля «Curve List» указываем боковую кромку поверхности 1 (т.е. Sur-

face 1.4). Apply. 

Расположение опорных точек показано на рисунке 10.2. 

8. Разбить поверхности на конечные элементы. 

Устанавливаем сочетание Create/ Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad 

 «Mesher»: IsoMesh 

 «Topology»: Quad4. 

Активизируем поле «Surface List» и в графическом окне указываем сразу 

все поверхности (Surface 1:3). 

Apply. 

9. Сшить конечно-элементную модель. 

Устанавливаем сочетание Equivalence/All/Tolerance Cube. 

Ничего не меняя, нажимаем Apply. При этом места сшивки модели будут 

обведены кружочками. 
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Рисунок 10.2 – Опорные точки сетки 

 

10. Построить модель трёхмерного ортотропного материала для обшивок. 
Запускаем приложение «Materials» и устанавливаем сочетание Create/ 

3d Orthotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например skin. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 6.5e4 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 4.2e4 (модуль упругости 2E , МПа) 

 «Elastic Modulus 33» = 8e3 (модуль упругости 3E , МПа) 

 «Poisson Ratio 12» = 0.15 (коэффициент Пуассона 12µ ) 

 «Poisson Ratio 23» = 0.3 (коэффициент Пуассона 23µ ) 

 «Poisson Ratio 31» = 0.037 (коэффициент Пуассона 31µ ) 

 «Shear Modulus 12» = 4e3 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 4e3 (модуль сдвига 23G , МПа) 

 «Shear Modulus 31» = 4e3 (модуль сдвига 31G , МПа) 

OK. 

Наиболее распространённой здесь ошибкой является задание коэффици-

ента Пуассона 13µ  вместо 31µ . Напомним, что 3
31 13

1

E

E
µ µ= . 

Нажимаем Apply. 

11. Построить модель трёхмерного ортотропного материала для заполнителя. 
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В поле «Material Name» вводим другое имя материала, например core. 

Далее нажимаем кнопку Input Properties и вводим упругие свойства: 

 «Elastic Modulus 11» = 100 (модуль упругости 1E , МПа) 

 «Elastic Modulus 22» = 100 (модуль упругости 2E , МПа) 

 «Elastic Modulus 33» = 3e3 (модуль упругости 3E , МПа) 

 «Poisson Ratio 12» = 0.1 (коэффициент Пуассона 12µ ) 

 «Poisson Ratio 23» = 0.01 (коэффициент Пуассона 23µ ) 

 «Poisson Ratio 31» = 0.3 (коэффициент Пуассона 31µ ) 

 «Shear Modulus 12» = 60 (модуль сдвига 12G , МПа) 

 «Shear Modulus 23» = 300 (модуль сдвига 23G , МПа) 

 «Shear Modulus 31» = 300 (модуль сдвига 31G , МПа) 

OK. 

Apply. 

12. Открыть новую базу данных в MSC.Laminate Modeler. 

В полосе меню выбираем команду Tools>Laminate Modeler>Layup/  

Laminate. 

В окне инициализации нажимаем кнопку New Layup File и вводим имя 

файла базы данных, например Clab10.Layup, OK. 

13. Создать LM-материалы. 

В выпадающих меню приложения MSC.Laminate Modeler выбираем соче-

тание Create/LM_Material/Add. 

Используем тип Drape (Scissor). 

В списке «Analysis Materials» указываем материал skin и в поле 

«Thickness» вводим значение толщины (в мм): 2. 

Apply. 

Для второго LM-материала в списке «Analysis Materials» указываем core и 

в поле «Thickness» вводим значение толщины (в мм): 5. 

Apply. 

14. Создать LM-слои. 

Устанавливаем сочетание Create/LM_Ply/Add. 

Для первого LM-слоя в списке «Select LM_Material» выделяем материал 

Mat_1. 

Активизируем поле «Select Area» и в графическом окне указываем все по-

верхности (Surface 1:3). 
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За начальную точку примем середину нижней кромки поверхности 1, т.е. 

«Start Point»: Point 7. 

Вводим: 

 «Application Direction»: <-1. 0. 0.> (направление прикладывания) 

 «Reference Direction»: Coord 0.2 (базовое направление) 

 «Reference Angle»: 0 (базовый угол). 

Apply. 

Для второго LM-слой в списке «Select LM_Material» выделяем материал 

Mat_2. 

Apply. 

15. Создать LM-пакет. 

Устанавливаем сочетание Create/LM_Layup/Add. 

Нажимаем кнопку Layup Definition и из списка «Existing LM_Plys» выби-

раем слои Ply_1, Ply_2 и снова Ply_1. OK. 

Отметим, что по умолчанию поверхность формы (определяемая сеткой 

оболочечных элементов) будет совпадать со срединной поверхностью 

многослойного пакета, т.е. признак отступа (Offset Flag) принимает значе-

ние Middle, а сам отступ равен нулю. 

Для моделирования выкладки слоёв на поверхность формы её следует со-

вместить с нижней поверхностью многослойного пакета. 

Для переопределения отступов нажимаем кнопку Offset Definition. 

Выбираем режим «Define Offsets». 

Выделяем первую строку таблицы «Define Offsets» и в соответствующие 

поля вводим: 

 «Name»: 1 

 «Select Area»: Surface 1:3 (выбор области) 

 «Definition Point»: Point 7 (определяющая точка) 

 «Definition Direction»: <-1. 0. 0.> (определяющее направление взгляда) 

 «Offset Value»: 0 (значение отступа, мм) 

 «Offset Flag»: Top (признак отступа) 

Create. 

В первой строке таблицы должна появиться запись 1. OK. 

Снимаем флаг «Analysis Model». 

Apply. 

16. Построить объёмные элементы. 

Устанавливаем сочетание Create/Solid Elements/LM_Layup. 
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Для выбора всех оболочечных элементов используем «Select»: All. 

Нажимаем кнопку Extrusion Controls (управление вытягиванием оболо-

чечных элементов в объёмные). При этом появляется дополнительная па-

нель, где можно задать число элементов по толщине. 

Следует отметить, что в трансверсальном направлении здесь можно вы-

брать либо один элемент по толщине (задаётся по умолчанию), либо один 

элемент на каждый слой. Другие возможности пока не реализованы. 

Включаем опцию «Per Ply» (один элемент на каждый слой). 

OK. 

Для создания отдельной группы, содержащей объёмные элементы, а также 

расчётной модели для анализа устанавливаем флаги «Create Group» и 

«Analysis Model». 

Для выбора типа элементов нажимаем кнопку Select Element Type и указы-

ваем строку 3D_Composite Solid (PCOMP/G/LS). OK. 

Apply. 

Приложение MSC.Laminate Modeler можно закрыть. Нажимаем Close и 

Cancel. 

17. Отобразить системы координат объёмных элементов. 

Чтобы удалить из графического окна изображение оболочечных элемен-

тов, в полосе меню выбираем команду Group>Post и в списке «Select 

Groups to Post» указываем только группу LM_Solid_Elements. Apply. 

Запускаем приложение «Elements» и устанавливаем сочетание 

Show/Element/Coord. Sys. 

Для поля «Select Elements» указываем все элементы. 

Apply. 

18. Задать граничные условия. 
Запускаем приложение «Loads/BCs» и для задания перемещений выбира-

ем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя вновь создаваемого набора, например 

clamped. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <0,0,0>, OK. 

Нажимаем Select Application Region. Для выбора конечно-элементных объ-

ектов устанавливаем опцию «Select»: FEM. 

Активизируем поле «Select Nodes» и указываем все узлы, расположенные 

в основании упора (см. рисунок 10.1). 

Последовательно нажимаем кнопки Add, OK и Apply. 
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19. Приложить нагрузку. 
Для задания давления в том же приложении выбираем сочетание Create/ 

Pressure/Element Uniform. 

В поле «New Set Name» вводим имя нового набора, например load. 

В качестве типа целевых элементов выбираем объёмные, т.е. «Target Ele-

ment Type»: 3D. 

Нажимаем кнопку Input Data и в поле «Pressure» вводим значение 10 (в 

МПа). OK. 

Далее нажимаем кнопку Select Application Region. Используем опцию «Se-

lect»: FEM. 

Активизируем поле «Select 3D Element Faces» и указываем грани объём-

ных элементов, представляющие внутреннюю цилиндрическую поверх-

ность упора (т.е. Elm 263:272:3.5). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

20. Запустить задачу на счёт. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Selected Group/Full Run. 

Нажимаем кнопку Select Group и в списке существующих групп выбираем 

строку LM_Solid_Elements. Cancel. 

Нажимаем кнопку Translation Parameters и снимаем флаг «Write Global 

Ply IDs», OK. 

Следует отметить, что устанавливаемая по умолчанию последователь-

ность решения SOL 101 программы MSC.Nastran не поддерживает объём-

ные слоистые элементы. 

Для выбора другой последовательности решения нажимаем кнопку Solu-

tion Type, а затем Solution Parameters. 

Устанавливаем флаг «SOL 600 Run» (расчёт с использованием программы 

MSC.Marc). OK. 

OK. 

Apply. 

Отметим, что в версии 2012 MSC.Nastran для расчёта объёмных слоистых 

конструкций рекомендуется использовать новую последовательность ре-

шений SOL 400. 

21. Присоединить файл результатов расчёта к базе данных программы 

MSC.Patran. 
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В том же приложении для доступа к результатам расчёта устанавливаем 

сочетание Access Results/Attach T16/T19/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

clab10.marc.t16, OK. 

В заключение нажимаем Apply. 

22. Изобразить напряжённо-деформированное состояние упора. 
Запускаем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 

В списке «Select Result Cases» указываем второй случай результатов. 

Для изображения поля напряжений в списке «Select Fringe Result» указы-

ваем строку Stress, Preferred System. 

И наконец, в списке «Select Deformation Result» выбираем Displacement, 

Translation. 

Apply. 

Получаемое при этом изображение результатов представлено на рисун-

ке 10.3. Видно, что максимальное эквивалентное напряжение составляет 

85,5 МПа, а максимальное перемещение равно 2,77 мм. 

 

 
Рисунок 10.3 – Поле напряжений по Мизесу (МПа)  

 

23. Выйти из программы: File>Quit. 

 

 


